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LMF Operating System Installation

This section provides information and instructions for installing and
updating the LMF software and files.

NOTE First Time Installation Sequence:
1. Install Java Runtime Environment (JRE)

2. Install U/WIN K–shell emulator

3. Install LMF application programs

4. Install/create BTS folders

NOTE Any time you install U/WIN, you must install the LMF software
because the installation of the LMF modifies some of the files
that are installed during the U/Win installation. Installing U/Win
over–writes these modifications.

There are multiple binary image packages for installation on the
CD–ROM. When prompted, choose the load that corresponds to
the switch release that you currently have installed. Perform the
Device Images install after the WinLMF installation.

If applicable, a separate CD ROM of BTS Binaries may be
available for binary updates.

Follow the procedure in Table 3-1 to install the LMF application
program using the LMF CD ROM.

Table 3-1: Install LMF using CD ROM

n Step Action

1 Insert the LMF CD ROM disk into your disk drive and perform the
following as required:

1a – If the Setup screen appears, follow the instructions displayed on
the screen.

1b – If the Setup screen is not displayed, proceed to Step 2.

2 Click on the Start button.

3 Select Run.

4 Enter d:\autorun in the Open box and click OK.

NOTE
If applicable, replace the letter d with the correct CD ROM drive
letter.
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Copy BTS and CBSC CDF (or NECF) Files to the LMF Computer

Before logging on to a BTS with the LMF computer to execute
optimization/ATP procedures, the correct bts-#.cdf (or bts–#.necf) and
cbsc-#.cdf files must be obtained from the CBSC and put in a bts-#
folder in the LMF computer. This requires creating versions of the
CBSC CDF files on a DOS–formatted floppy diskette and using the
diskette to install the CDF files on the LMF computer.

NOTE – If the LMF has ftp capability, the ftp method can be used to
copy the CDF or NECF files from the CBSC.

– On Sun OS workstations, the unix2dos command can be
used in place of the cp command (e.g., unix2dos
bts–248.cdf bts–248.cdf). This should be done using a copy
of the CBSC CDF file so the original CBSC CDF file is
not changed to DOS format.

NOTE When copying CDF or NECF files, comply with the following
to prevent BTS login problems with the Windows LMF:

S The numbers used in the bts-#.cdf (or bts–#.necf) and
cbsc-#.cdf filenames must correspond to the locally-assigned
numbers for each BTS and its controlling CBSC.

S The generic cbsc–1.cdf file supplied with the Windows LMF
will work with locally numbered BTS CDF files. Using this
file will not provide a valid optimization unless the generic
file is edited to replace default parameters (e.g., channel
numbers) with the operational parameters used locally.

The procedure in Table 3-2 lists the steps required to transfer the CDF
files from the CBSC to the LMF computer. For further information, refer
to the LMF Help function on–line documentation.

Table 3-2: Copying CDF or NECF Files to the LMF Computer

n Step Action

AT THE CBSC:

1 Login to the CBSC workstation.

2 Insert a DOS–formatted floppy diskette in the workstation drive.

3 Type eject –q and press the Enter key.

4 Type mount and press the Enter key.

NOTE
S Look for the “floppy/no_name” message on the last line displayed.

S If the eject command was previously entered, floppy/no_name will be appended with a number.
Use the explicit floppy/no_name reference displayed when performing Step 7.

5 Change to the directory, where the files to be copied reside, by typing cd <directoryname>
(e.g., cd bts–248) and pressing the Enter key.

6 Type ls and press the Enter key to display the list of files in the directory.

. . . continued on next page
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Table 3-2: Copying CDF or NECF Files to the LMF Computer

n ActionStep

7 With Solaris versions of Unix, create DOS–formatted versions of the bts-#.cdf (or bts–#.necf) and
cbsc-#.cdf files on the diskette by entering the following command:

unix2dos <source filename>  /floppy/no_name/<target filename>
(e.g., unix2dos bts–248.cdf  /floppy/no_name/bts–248.cdf).

NOTE
S Other versions of Unix do not support the unix2dos and dos2unix commands. In these cases, use

the Unix cp (copy) command. The copied files will be difficult to read with a DOS or Windows text
editor because Unix files do not contain line feed characters. Editing copied CDF files on the LMF
computer is, therefore, not recommended.

S Using cp, multiple files can be copied in one operation by separating each filename to be copied
with a space and ensuring the destination directory (floppy/no_name) is listed at the end of the
command string following a space (e.g., cp  bts–248.cdf  cbsc–6.cdf  /floppy/no_name).

8 Repeat Steps 5 through 7 for each bts–# that must be supported by the LMF computer.

9 When all required files have been copied to the diskette type eject and press the Enter key.

10 Remove the diskette from the CBSC drive.

AT THE LMF:

11 If it is not running, start the Windows operating system on the LMF computer.

12 Insert the diskette containing the bts-#.cdf (or bts–#.necf) and cbsc-#.cdf files into the LMF
computer.

13 Using MS Windows Explorer, create a corresponding bts–# folder in the <x>:\<lmf home
directory>\cdma directory for each bts-#.cdf (or bts–#.necf) and cbsc-#.cdf file pair copied from the
CBSC.

14 Use MS Windows Explorer to transfer the bts-#.cdf (or bts–#.necf) and cbsc-#.cdf files from the
diskette to the corresponding <x>:\<lmf home directory>\cdma\bts–# folders created in Step 13.
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Creating a Named HyperTerminal Connection for MMI Connection
Confirming or changing the configuration data of certain BTS Field
Replaceable Units (FRU) requires establishing an MMI communication
session between the LMF and the FRU. Using features of the Windows
operating system, the connection properties for an MMI session can be
saved on the LMF computer as a named Windows HyperTerminal
connection. This eliminates the need for setting up connection
parameters each time an MMI session is required to support
optimization.

Once the named connection is saved, a shortcut for it can be created on
the Windows desktop. Double–clicking the shortcut icon will start the
connection without the need to negotiate multiple menu levels.

Follow the procedure in Table 3-3 to establish a named HyperTerminal
connection and create a Windows desktop shortcut for it.

Table 3-3: Creating a Named Hyperlink Connection for MMI Connection

Step Action

1 From the Windows Start menu, select:

Programs>Accessories>

2 Perform one of the following:

S For Win NT, select Hyperterminal and then click on HyperTerminal or

S For Win 98, select Communications, double click the Hyperterminal folder, and then double click
on the Hyperterm.exe icon in the window that opens.

NOTE
S If a Location Information Window appears, enter the required information, then click  Close.

(This is required the first time, even if a modem is not to be used.)

S If a You need to install a modem..... message appears, click NO.

3 When the Connection Description box opens:

– Type a name for the connection being defined (e.g., MMI Session) in the Name: window.

– Highlight any icon preferred for the named connection in the Icon: chooser window.

– Click OK.

4 From the Connect using: pick list in the Connect To box displayed, select COM1 or COM2 (Win
NT) – or Direct to Com 1 or Direct to Com 2 (Win 98) for the RS–232 port connection and click OK.

NOTE
For LMF configurations where COM1 is used by another interface such as test equipment and a
physical port is available for COM2, select COM2 to prevent conflicts.

5 In the Port Settings tab of the COM# Properties window displayed, configure the RS–232 port
settings as follows:

S Bits per second: 9600

S Data bits: 8

S Parity: None

S Stop bits: 1

S Flow control: None

. . . continued on next page
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Table 3-3: Creating a Named Hyperlink Connection for MMI Connection

Step Action

6 Click OK.

7 Save the defined connection by selecting:

File>Save

8 Close the HyperTerminal window by selecting:

File>Exit

9 Click Yes to disconnect when prompted.

10 Perform one of the following:

S If the Hyperterminal folder window is still open (Win 98) proceed to step 12

S From the Windows Start menu, select Programs > Accessories.

11 Perform one of the following:

S For Win NT, select Hyperterminal and release any pressed mouse buttons.

S For Win 98, select Communications and double click the Hyperterminal folder.

12 Highlight the newly created connection icon by moving the cursor over it (Win NT) or clicking on it
(Win 98).

13 Right click and drag the highlighted connection icon to the Windows desktop and release the right
mouse button.

14 From the pop–up menu displayed, select Create Shortcut(s) Here.

15 If desired, reposition the shortcut icon for the new connection by dragging it to another location on the
Windows desktop.

16 Close the Hyperterminal folder window by selecting:

File > Close
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Span Lines – Interface and Isolation

T1/E1 Span Interface

NOTE At active sites, the OMC/CBSC must disable the BTS and place
it out of service (OOS). DO NOT remove the 50–pin TELCO
cable connected to the BTS frame site I/O board J1 connector
until the OMC/CBSC has disabled the BTS!

Each frame is equipped with one Site I/O and two Span I/O boards. The
Span I/O J1 connector provides connection of 25 pairs of wire. A GLI
card can support up to six spans. In the SC 4812T configuration, the odd
spans (1, 3, and 5) terminate on the Span “A” I/O; and the even spans (2,
4, and 6) terminate on the Span “B” I/O.

Before connecting the LMF to the frame LAN, the OMC/CBSC must
disable the BTS and place it OOS to allow the LMF to control the
CDMA BTS. This prevents the CBSC from inadvertently sending
control information to the CDMA BTS during LMF based tests. Refer to
Figure 3-2 and Figure 3-3 as required.

Isolate BTS from T1/E1 Spans

Once the OMC–R/CBSC has disabled the BTS, the spans must be
disabled to ensure the LMF will maintain control of the BTS. To disable
the spans, disconnect the span cable connectors from the Span I/O cards
(see Figure 3-2).

Figure 3-2: Span I/O Board T1 Span Isolation

50–PIN TELCO
CONNECTORS
REMOVED

SPAN A CONNECTOR
(TELCO) INTERFACE
TO SPAN LINES

SPAN B CONNECTOR
(TELCO) INTERFACE
TO SPAN LINES

TOP of Frame
 (Site I/O and Span I/O boards)

RS–232 9–PIN SUB D
CONNECTOR SERIAL
PORT FOR EXTERNAL
DIAL UP MODEM
CONNECTION (IF USED)

FW00299
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T1/E1 Span Isolation

Table 3-4 describes the action required for span isolation.

Table 3-4: T1/E1 Span Isolation

Step Action

1 Have the OMC/CBSC place the BTS OOS.

2 The T1/E1 span 50–pin TELCO cable connected to the BTS
frame SPAN I/O board J1 connector can be removed from
both Span I/O boards, if equipped, to isolate the spans.

NOTE
If a third party is used for span connectivity, the third party
must be informed before disabling the span line.

Verify that you remove the SPAN cable, not the
“MODEM/TELCO” connector.
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LMF to BTS Connection

Connect the LMF to the BTS

The LMF is connected to the LAN A or B connector located on the left
side of the frame’s lower air intake grill, behind the LAN Cable Access
door (see Figure 3-3).

Table 3-5: LMF to BTS Connection

Step Action

1 To gain access to the connectors, open the LAN cable access door, then pull apart the fabric covering
the BNC “T” connector (see Figure 3-3).

2 Connect the LMF to the LAN A BNC connector via PCMCIA Ethernet Adapter with an unshielded
twisted–pair (UTP) Adapter and 10BaseT/10Base2 converter (powered by an external AC/DC
transformer). If there is no login response, connect the LMF to the LAN B connector. If there is still
no login response, see Table 6-1, Login Failure Troubleshooting Procedures.

NOTE
Xircom Model PE3–10B2 or equivalent can also be used to interface the LMF Ethernet connection to
the frame connected to the PC parallel port, powered by an external AC/DC transformer. In this case,
the BNC cable must not exceed 91 cm (3 ft) in length.

* IMPORTANT
The LAN shield is isolated from chassis ground. The LAN shield (exposed portion of BNC connector)
must not touch the chassis during optimization.

Figure 3-3: LMF Connection Detail

NOTE:
Open LAN CABLE ACCESS
door. Pull apart Velcro tape and
gain access to the LAN A or LAN
B LMF BNC connector.

LMF BNC “T” CONNECTIONS
ON LEFT SIDE OF FRAME
(ETHERNET “A” SHOWN;
ETHERNET “B” COVERED

WITH VELCRO TAPE)

ÁÁ
Á

LMF COMPUTER
TERMINAL WITH

MOUSE PCMCIA ETHERNET
ADPATER & ETHERNET

UTP ADAPTER

10BASET/10BASE2
CONVERTER CONNECTS

DIRECTLY TO BNC T   

115 VAC POWER
CONNECTION

Á

FW00140

Á

UNIVERSAL TWISTED
PAIR (UTP) CABLE (RJ11

CONNECTORS)
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Using the LMF

Basic LMF Operation

LMF Coverage in This Publication – The LMF application program
supports maintenance of both CDMA and SAS BTSs. All references to
the LMF in this publication are to the CDMA portion of the program.

Operating Environments – The LMF application program allows the
user to work in the two following operating environments which are
accessed using the specified desktop icons:

S Graphical User Interface (GUI) using the WinLMF icon

S Command Line Interface (CLI) using the WinLMF CDMA CLI icon

The GUI is the primary optimization and acceptance testing operating
environment. The CLI environment provides additional capability to the
user to perform manually controlled acceptance tests and audit the
results of optimization and calibration actions.

Basic Operation – Basic operation of the LMF in either environment
includes performing the following:

S Selecting and deselecting BTS devices

S Enabling devices

S Disabling devices

S Resetting devices

S Obtaining device status

The following additional basic operation can be performed in a GUI
environment:

S Sorting a status report window

For detailed information on performing these and other LMF operations,
refer to the LMF Help function on–line documentation.

NOTE Unless otherwise noted, LMF procedures in this manual are
performed using the GUI environment.
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The LMF Display and the BTS

BTS Display – When the LMF is logged into a BTS, a frame tab is
displayed for each BTS frames. The frame tab will be labeled with
“CDMA” and the BTS number, a dash, and the frame number (for
example, BTS–812–1 for BTS 812, RFMF 1). If there is only one frame
for the BTS, there will only be one tab.

CDF/NECF Requirements – For the LMF to recognize the devices
installed in the BTS, a BTS CDF/NECF file which includes equipage
information for all the devices in the BTS must be located in the
applicable <x>:\<lmf home directory>\cdma\bts–# folder. To provide
the necessary channel assignment data for BTS operation, a CBSC CDF
file which includes channel data for all BTS RFMFs is also required in
the folder.

RFDS Display – If an RFDS is included in the CDF/NECF file, an
RFDS tab labeled with “RFDS,” a dash and the BTS number–frame
number combination (for example, RFDS–812–1) will be displayed.

Graphical User Interface Overview

The LMF uses a GUI, which works in the following way:

S Select the device or devices.

S Select the action to apply to the selected device(s).

S While action is in progress, a status report window displays the action
taking place and other status information.

S The status report window indicates when the the action is complete
and displays other pertinent information.

S Clicking the OK button closes the status report window.
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Understanding GUI Operation

The following screen captures are provided to help understand how the
GUI operates:

– Figure 3-4 depicts the differences between packet and circuit
CDMA “cdf” file identification. Note that if there is a packet
version “bts” file, the “(P)” is added as a suffix. There is a
corresponding “(C)” for the circuit mode version.

– Figure 3-5 depicts the Self-Managed Network Elements (NEs) state
of a packet mode SC4812T. Note that an “X” is on the front of each
card that is under Self–Managed Network Elements (NEs) control
by the GLI3 card.

– Figure 3-6 depicts three of the available packet mode commands.
Normally the GLI3 has Self-Managed Network Elements (NEs)
control of all cards as shown in Figure 3-5 by an “(X)”. In that state
the LMF may only status a card. In order to download code or test a
card, the LMF must request Self-Managed Network Elements (NEs)
control of the card by using the shown dropdown menu. It also uses
this menu to release control of the card back to the GLI3. The GLI3
will also assume control of the cards after the LMF logs out of the
BTS. The packet mode GLI3 normally is loaded with a tape release
and NECB and NECJ files which point to a tape release stored on
the GLI3. When the GLI3 has control of a card it will maintain that
card with the code on that tape release.

– Figure 3-7 depicts a packet mode site that has the MCC–1 and the
BBX–1 cards under LMF control. Notice that the “X” is missing
from the front of these two cards.

For detailed information on performing these and other LMF operations,
refer to the LMF Help function on–line documentation.
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Figure 3-4: BTS Login screen – identifying circuit and packet BTS files
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Figure 3-5: Self–Managed Network Elements (NEs) state of a packet mode SC4812T
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Figure 3-6: Available packet mode commands
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Figure 3-7: Packet mode site with MCC–1 and BBX–1 under LMF control
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Command Line Interface Overview

The LMF also provides Command Line Interface (CLI) capability.
Activate the CLI by clicking on a shortcut icon on the desktop. The CLI
can not be launched from the GUI, only from the desktop icon.

Both the GUI and the CLI use a program known as the handler. Only one
handler can be running at one time. Due to architectural limitations, the
GUI must be started before the CLI if you want the GUI and CLI to use
the same handler. When the CLI is launched after the GUI, the CLI
automatically finds and uses an in–progress login session with a BTS
initiated under the GUI. This allows the use of the GUI and the CLI in
the same BTS login session. If a CLI handler is already running when
the GUI is launched (this happens if the CLI window is already running
when the user starts the GUI, or if another copy of the GUI is already
running when the user starts the GUI), a dialog window displays the
following warning message:

The CLI handler is already running.
This may cause conflicts with the LMF.
Are you sure you want to start the application?
           Yes       No

This window also contains Yes and No buttons. Selecting Yes starts the
application. Selecting No terminates the application.

CLI Format Conventions

The CLI command syntax is as follows:

S verb

S device including device identifier parameters

S switch

S option parameters consisting of:

– keywords

– equals signs (=) between the keywords and the parameter values

– parameter values

Spaces are required between the verb, device, switch, and option
parameters. A hyphen is required between the device and its identifiers.
Following is an example of a CLI command.

measure bbx–<bts_id>–<bbx_id> rssi channel=6 sector=5

Refer to LMF CLI Commands for a complete explanation of the CLI
commands and their usage.
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Logging into a BTS
Logging into a BTS establishes a communication link between the BTS
and the LMF. An LMF session can be logged into only one BTS at a
time.

Prerequisites

Before attempting to log into a BTS, ensure the following have been
completed:

S The LMF is correctly installed on the LMF computer.

S A bts-nnn folder with the correct CDF/NECF and CBSC files exists.

S The LMF computer was connected to the BTS before starting the
Windows operating system and the LMF software. If necessary, restart
the computer after connecting it to the BTS in accordance with
Table 3-5 and Figure 3-3.

CAUTION Be sure that the correct bts–#.cdf/necf and cbsc–#.cdf file are
used for the BTS. These should be the CDF/NECF files that are
provided for the BTS by the CBSC. Failure to use the correct
CDF/NECF files can result in invalid optimization. Failure to
use the correct CDF/NECF files to log into a live
(traffic–carrying) site can shut down the site.

BTS Login from the GUI Environment

Follow the procedure in Table 3-6 to log into a BTS when using the GUI
environment.

Table 3-6: BTS GUI Login Procedure

n Step Action

1 Start the CDMA LMF GUI environment by double clicking on the WinLMF desktop icon (if the
LMF is not running).

NOTE
If a warning similar to the following is displayed, select No, shut down other LMF sessions which
may be running, and start the CDMA LMF GUI environment again:

The CLI handler is already running.
This may cause conflicts with the LMF.
Are you sure you want to start the application?

Yes No

2 Click on the Login tab (if not displayed).

3 If no base stations are displayed in the Available Base Stations pick list, double click on the
CDMA icon.

4 Click on the desired BTS number. For explanation of BTS numbering, see Figure 3-4.

5 Click on the Network Login tab (if not already in the forefront).

6 Enter the correct IP address (normally 128.0.0.2 for a field BTS) if not correctly displayed in the
IP Address box.

. . . continued on next page
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Table 3-6: BTS GUI Login Procedure

n ActionStep

NOTE
128.0.0.2 is the default IP address for MGLI–1 in field BTS units. 128.0.0.1 is the default IP
address for MGLI–2.

7 Type in the correct IP Port number (normally 9216) if not correctly displayed in the IP Port box.

8 Click on Ping.

– If the connection is successful, the Ping Display window shows text similar to the following:

Reply from 128 128.0.0.2: bytes=32 time=3ms TTL=255

– If there is no response the following is displayed:

128.0.0.2:9216:Timed out

If the MGLI fails to respond, reset and perform the ping process again. If the MGLI still fails to
respond, typical problems are shorted BNC to inter–frame cabling, open cables, crossed A and B
link cables, missing 50–Ohm terminators, or the MGLI itself.

9 Change the Multi-Channel Preselector (from the Multi-Channel Preselector pick list), normally
MPC, corresponding to your BTS configuration, if required.

NOTE
When performing RX tests on expansion frames, do not choose EMPC if the test equipment is
connected to the starter frame.

10 Click on the Use a Tower Top Amplifier, if applicable.

11 Click on Login. (A BTS tab with the BTS and frame numbers is displayed.)

NOTE
S If you attempt to login to a BTS that is already logged on, all devices will be gray.

S There may be instances where the BTS initiates a log out due to a system error (i.e., a device
failure).

S If the MGLI is OOS_ROM (blue), it will have to be downloaded with code before other devices
can be seen.

S If the MGLI is OOS–RAM (yellow), it must be enabled before other installed devices can be
seen.
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BTS Login from the CLI Environment

Follow the procedure in Table 3-7 to log into a BTS when using the CLI
environment.

NOTE If the CLI and GUI environments are to be used at the same
time, the GUI must be started first and BTS login must be
performed from the GUI. Refer to Table 3-6 to start the GUI
environment and log into a BTS.

Table 3-7: BTS CLI Login Procedure

n Step Action

1 Double–click the WinLMF CLI desktop icon (if the LMF CLI
environment is not already running).

NOTE
If a BTS was logged into under a GUI session before the CLI
environment was started, the CLI session will be logged into the same
BTS, and Step 2 is not required.

2 At the /wlmf prompt, enter the following command:

login bts–<bts#>  host=<host>  port=<port>

where:

host = MGLI card IP address (defaults to address last logged into for
this BTS or 128.0.0.2 if this is first login to this BTS)

port = IP port of the BTS (defaults to port last logged into for this
BTS or 9216 if this is first login to this BTS)

A response similar to the following will be displayed:

LMF>
13:08:18.882 Command Received and Accepted
             COMMAND=login bts–33

13:08:18.882 Command In Progress

13:08:21.275 Command Successfully Completed
             REASON_CODE=”No Reason”
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Logging Out

Logging out of a BTS is accomplished differently for the GUI and CLI
operating environments.

NOTE The GUI and CLI environments use the same connection to a
BTS. If a GUI and the CLI session are running for the same BTS
at the same time, logging out of the BTS in either environment
will log out of it for both. When either a login or logout is
performed in the CLI window, there is no GUI indication that the
login or logout has occurred.

Logging Out of a BTS from the GUI Environment

Follow the procedure in Table 3-8 to logout of a BTS when using the
GUI environment.

Table 3-8: BTS GUI Logout Procedure

n Step Action

1 Click on BTS on the BTS tab menu bar.

2 Click the Logout item in the pull–down menu (a Confirm Logout
pop–up message will appear).

3 Click on Yes or press the <Enter> key to confirm logout. The Login
tab will appear.

NOTE
If a logout was previously performed on the BTS from a CLI window
running at the same time as the GUI, a Logout Error pop–up
message appears stating the system should not log out of the BTS.
When this occurs, the GUI must be exited and restarted before it can
be used for further operations.

4 If a Logout Error pop–up message appears stating that the system
could not log out of the Base Station because the given BTS is not
logged in, click OK and proceed to Step 5.

5 Select File > Exit in the window menu bar, click Yes in the Confirm
Logout pop–up, and click OK in the Logout Error pop–up which
appears again.

6 If further work is to be done in the GUI, restart it.

NOTE
S The Logout item on the BTS menu bar will only log you out of the

displayed BTS.

S You can also log out of all BTS sessions and exit LMF by clicking
on the File selection in the menu bar and selecting Exit from the
File menu list. A Confirm Logout pop–up message will appear.
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Logging Out of a BTS from the CLI Environment

Follow the procedure in Table 3-9 to logout of a BTS when using the
CLI environment.

Table 3-9: BTS CLI Logout Procedure

n Step Action

NOTE
If the BTS is also logged into from a GUI running at the same time
and further work must be done with it in the GUI, proceed to Step 2.

1 Log out of a BTS by entering the following command:

logout bts–<bts#>

A response similar to the following will be displayed:

LMF>
13:24:51.028 Command Received and Accepted

COMMAND=logout bts–33
13:24:51.028 Command In Progress
13:24:52.04 Command Successfully Completed

REASON_CODE=”No Reason”

2 If desired, close the CLI interface by entering the following
command:

exit

A response similar to the following will be displayed before the
window closes:

Killing background processes....
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Establishing an MMI Communication Session

Equipment Connection – Figure 3-8 illustrates common equipment
connections for the LMF computer. For specific connection locations on
FRUs, refer to the illustration accompanying the procedures which
require the MMI communication session.

Initiate MMI Communication – For those procedures which require
MMI communication between the LMF and BTS FRUs, follow the
procedures in Table 3-10 to initiate the communication session.

Table 3-10: Establishing MMI Communications

Step Action

1 Connect the LMF computer to the equipment as detailed in the applicable procedure that requires the
MMI communication session.

2 If the LMF computer has only one serial port (COM1) and the LMF is running, disconnect the LMF
from COM1 by performing the following:

2a – Click on Tools in the LMF window menu bar, and select Options from the pull–down menu list.
–– An LMF Options dialog box will appear.

2b – In the LMF Options dialog box, click the Disconnect Port button on the Serial Connection tab.

3 Start the named HyperTerminal connection for MMI sessions by double clicking on its Windows
desktop shortcut.

NOTE
If a Windows desktop shortcut was not created for the MMI connection, access the connection from the
Windows Start menu by selecting:

Programs > Accessories > Hyperterminal > HyperTerminal > <Named HyperTerminal
Connection (e.g., MMI Session)>

4 Once the connection window opens, establish MMI communication with the BTS FRU by pressing
the LMF computer <Enter> key until the prompt identified in the applicable procedure is obtained.
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Figure 3-8: CDMA LMF Computer Common MMI Connections

NULL MODEM
BOARD

(TRN9666A)

8–PIN TO 10–PIN
RS–232 CABLE
(P/N 30–09786R01)

RS–232 CABLE

8–PIN

LMF
COMPUTER

To FRU MMI port

DB9–TO–DB25
ADAPTER

COM1
OR

COM2

FW00687

Online Help

Task oriented online help is available in the LMF by clicking on Help in
the window menu bar, and selecting LMF Help from the pull–down
menu.
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Pinging the Processors

Pinging the BTS

For proper operation, the integrity of the Ethernet LAN A and B links
must be be verified. Figure 3-9 represents a typical BTS Ethernet
configuration. The drawing depicts one link (of two identical links),
A and B.

Ping is a program that routes request packets to the LAN network
modules to obtain a response from the specified “targeted” BTS.

Figure 3-9: BTS Ethernet LAN Interconnect Diagram
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Follow the procedure in Table 3-11 and refer to Figure 3-9 as required to
ping each processor (on both LAN A and LAN B) and verify LAN
redundancy is operating correctly.

CAUTION Always wear a conductive, high impedance wrist strap while
handling any circuit card/module to prevent damage by ESD.
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NOTE IMPORTANT: The Ethernet LAN A and B cables must be
installed on each frame/enclosure before performing this test. All
other processor board LAN connections are made via the
backplanes.

Table 3-11: Pinging the Processors

n Step Action

1 If you have not already done so, connect the LMF to the BTS (see Table 3-5 on page 3-17).

2 From the Windows desktop, click the Start button and select Run.

3 In the Open box, type ping and the <MGLI IP address> (for example, ping 128.0.0.2).

NOTE
128.0.0.2 is the default IP address for MGLI–1 in field BTS units. 128.0.0.1 is the default IP
address for MGLI–2.

4 Click on the OK button.

5 If the connection is successful, text similar to the following is displayed:

Reply from 128 128.0.0.2: bytes=32 time=3ms TTL=255

If there is no response the following is displayed:

Request timed out

If the MGLI fails to respond, reset and perform the ping process again. If the MGLI still fails to
respond, typical problems are shorted BNC to inter-frame cabling, open cables, crossed A and B
link cables, missing 50–Ohm terminators, or the MGLI itself.
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Download the BTS

Overview
Before a BTS can operate, each equipped device must contain device
initialization (ROM) code. ROM code is loaded in all devices during
manufacture or factory repair, or, for software upgrades, from the CBSC
using the DownLoad Manager (DLM). Device application (RAM) code
and data must be downloaded to each equipped device by the user before
the BTS can be made fully functional for the site where it is installed.

ROM Code
Downloading ROM code to BTS devices from the LMF is NOT routine
maintenance nor a normal part of the optimization process. It is only
done in unusual situations where the resident ROM code in the device
does not match the release level of the site operating software AND the
CBSC cannot communicate with the BTS to perform the download.

If you must download ROM code, the procedures are located in
Appendix G.

Before ROM code can be downloaded from the LMF, the correct ROM
code file for each device to be loaded must exist on the LMF computer.
ROM code must be manually selected for download.

NOTE The ROM code file is not available for GLI3s. GLI3s are ROM
code loaded at the factory.

ROM code can be downloaded to a device that is in any state. After the
download is started, the device being downloaded will change to
OOS_ROM (blue). The device will remain OOS_ROM (blue) when the
download is completed. A compatible revision–level RAM code must
then be downloaded to the device. Compatible code loads for ROM and
RAM must be used for the device type to ensure proper performance.
The compatible device code release levels for the BSS software release
being used are listed in the Version Matrix section of the SCt CDMA
Release Notes (supplied on the tape or CD–ROM containing the BSS
software).

RAM Code
Before RAM code can be downloaded from the LMF, the correct RAM
code file for each device must exist on the LMF computer. RAM code
can be automatically or manually selected depending on the Device
menu item chosen and where the RAM code file for the device is stored
in the LMF file structure. The RAM code file will be selected
automatically if the file is in the <x>:\<lmf home
directory>\cdma\loads\n.n.n.n\code folder (where n.n.n.n is the
download code version number that matches the “NextLoad” parameter
of the CDF file). The RAM code file in the code folder must have the
correct hardware bin number for the device to be loaded.

RAM code can be downloaded to a device that is in any state. After the
download is started, the device being downloaded changes to OOS-ROM
(blue). When the download is completed successfully, the device will
change to OOS-RAM (yellow).
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When code is downloaded to an MGLI or GLI, the LMF automatically
also downloads data and then enables the MGLI. When enabled, the
MGLI will change to INS_ACT (bright green). A redundant GLI will
not be automatically enabled and will remain OOS_RAM (yellow).
When the redundant GLI is manually commanded to enable through the
LMF, it will change state to INS_SBY (olive green).

For non–MGLI devices, data must be downloaded after RAM code is
downloaded. To download data, the device state must be OOS–RAM
(yellow).

The devices to be loaded with RAM code and data are:

S Master Group Line Interface (MGLI2 or MGLI3)

S Redundant GLI (GLI2 or GLI3)

S Clock Synchronization Module (CSM) (Only if new revision code
must be loaded)

S Multi Channel Card (MCC24E, MCC8E or MCC–1X)

S Broadband Transceiver (BBX2 or BBX–1X)

S Test Subscriber Interface Card (TSIC) – if RFDS is installed

NOTE The MGLI must be successfully downloaded with code and data,
and put INS before downloading any other device. The
download code process for an MGLI automatically downloads
data and enables the MGLI before downloading other devices.
The other devices can be downloaded in any order.
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Verify GLI ROM Code Loads

Devices should not be loaded with a RAM code version which is not
compatible with the ROM code with which they are loaded. Before
downloading RAM code and data to the processor cards, follow the
procedure in Table 3-12 to verify the GLI devices are loaded with the
correct ROM code for the software release used by the BSS.

Prerequisite

Identify the correct GLI ROM code load for the software release being
used on the BSS by referring to the Version Matrix section of the SCt
CDMA Release Notes (supplied on the tapes or CD–ROMs containing
the BSS software).

Table 3-12: Verify GLI ROM Code Loads

Step Action

1 If it has not already been done, start a GUI LMF session and log into the
BTS ( refer to Table 3-6).

2 Select all GLI devices by clicking on them, and select Device > Status
from the BTS menu bar.

3 In the status report window which opens, note the number in the ROM
Ver column for each GLI.

4 If the ROM code loaded in the GLIs is not the correct one for the software
release being used on the BSS, perform the following:

4a – Log out of the BTS as described in Table 3-8 or Table 3-9, as
applicable.

4b – Disconnect the LMF computer.

4c – Reconnect the span lines as described in Table 5-7.

4d – Have the CBSC download the correct ROM code version to the BTS
devices.

5 When the GLIs have the correct ROM load for the software release being
used, be sure the span lines are disabled as outlined in Table 3-4 and
proceed to downloading RAM code and data.
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Download RAM Code and Data to MGLI and GLI
Follow the procedure in Table 3-13 to download the firmware
application code for the MGLI. The download code action downloads
data and also enables the MGLI.

Prerequisite

S Prior to performing this procedure, ensure a code file exists for each of
the devices to be loaded.

S The LMF computer is connected to the BTS (refer to Table 3-5), and
is logged in using the GUI environment (refer to Table 3-6).

Table 3-13: Download and Enable MGLI

n Step Action

1 Be sure the LMF will use the correct software release for code and
data downloads by performing the following steps:

1a – Click on Tools in the LMF menu bar, and select Update
NextLoad > CDMA from the pull–down menus.

1b – Click on the BTS to be loaded.
–– The BTS will be highlighted.

1c – Click the button next to the correct code version for the software
release being used.
–– A black dot will appear in the button circle.

1d – Click Save.

1e – Click OK to close each of the advisory boxes which appear.

2 Prepare to download code to the MGLI by clicking on the device.

3 Click Device in the BTS menu bar, and select Download >
Code/Data in the pull–down menus.

– A status report is displayed confirmimg change in the device(s)
status.

4 Click OK to close the status window.

– The MGLI will automatically be downloaded with data and
enabled.

5 Once the MGLI is enabled, load and enable additional installed GLIs
by clicking on the devices and repeating Steps 3 and 4.

6 Click OK to close the status window for the additional GLI devices.
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Download Code and Data to Non–GLI Devices
Downloads to non–GLI devices can be performed individually for each
device or all equipped devices can be downloaded with one action.

NOTE – When downloading multiple devices, the download may
fail for some of the devices (a time out occurs). These
devices can be downloaded separately after completing the
multiple download.

– CSM devices are RAM code–loaded at the factory. RAM
code is downloaded to CSMs only if updating to a newer
software version.

Follow the procedure in Table 3-14 to download RAM code and data to
non–GLI devices.

Table 3-14: Download RAM Code and Data to Non–GLI Devices

n Step Action

1 Select the target CSM, MCC, and/or BBX device(s) by clicking on
them.

2 Click Device in the BTS menu bar, and select Download >
Code/Data in the pull–down menus.

– A status report displays the result of the download for each
selected device.

3 Click OK to close the status report window when downloading is
completed.

NOTE
After a BBX, CSM or MCC is successfully downloaded with code
and has changed to OOS-RAM, the status LED should be rapidly
flashing GREEN.

NOTE
The command in Step 2 loads both code and data. Data can be
downloaded without doing a code download anytime a device is
OOS–RAM using the command in Step 4.

4 To download just the firmware application data to each device, select
the target device and select: Device>Download>Data

BBX Cards Remain OOS_ROM

If BBX cards remain OOS_ROM (blue) after power–up or following
code load, refer to Table 6-4, steps 9 and 10.
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Select CSM Clock Source
CSMs must be enabled prior to enabling the MCCs. Procedures in the
following two sub-sections cover the actions to accomplish this. For
additional information on the CSM sub–system, see “Clock
Synchronization Manager (CSM) Sub–system Description” in the CSM
System Time – GPS & LFR/HSO Verification section of this chapter.

Select CSM Clock Source

A CSM can have three different clock sources. The Clock Source
function can be used to select the clock source for each of the three
inputs. This function is only used if the clock source for a CSM needs to
be changed. The Clock Source function provides the following clock
source options:

S Local GPS

S Mate GPS

S Remote GPS

S HSO (only for sources 2 & 3)

S HSO Extender

S HSOX (only for sources 2 & 3)

S LFR (only for sources 2 & 3)

S 10 MHz (only for sources 2 & 3)

S NONE (only for sources 2 & 3)

Prerequisites
S MGLI is INS_ACT (bright green)

S CSM is OOS_RAM (yellow) or INS_ACT (bright green)

Follow the procedure in Table 3-15 to select a CSM Clock Source.

Table 3-15: Select CSM Clock Source

n Step Action

1 Select the applicable CSM(s) for which the clock source is to be
selected.

2 Click on Device in the BTS menu bar, and select CSM/MAWI >
Select Clock Source... in the pull–down menu list.

– A CSM clock reference source selection window will appear.

3 Select the applicable clock source in the Clock Reference Source
pick lists. Uncheck the related check boxes for Clock Reference
Sources 2 and 3 if you do not want the displayed pick list item to be
used.

4 Click on the OK button.

– A status report is displayed showing the results of the operation.

5 Click on the OK button to close the status report window.
 

NOTE For non–RGPS sites only, verify the CSM configured with the
GPS receiver “daughter board” is installed in the CSM–1 slot
before continuing.
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Enable CSMs

NOTE – CSMs are code loaded at the factory. This data is retained
in EEPROM. The download code procedure is required in
the event it becomes necessary to code load CSMs with
updated software versions. Use the status function to
determine the current code load versions.

– The CSM(s) to be enabled must have been downloaded
with code (Yellow, OOS–RAM) and data.

Each BTS CSM system features two CSM boards per site. In a typical
operation, the primary CSM locks its Digital Phase Locked Loop
(DPLL) circuits to GPS signals. These signals are generated by either an
on–board GPS module (RF–GPS) or a remote GPS receiver (R–GPS).
The CSM2 card is required when using the R–GPS. The GPS receiver
(mounted on CSM–1) is the primary timing reference and synchronizes
the entire cellular system. CSM–2 provides redundancy but does not
have a GPS receiver.

The BTS may be equipped with a remote GPS, LORAN–C LFR, HSO
10 MHz Rubidium source, or HSOX for expansion frames, which the
CSM can use as a secondary timing reference. In all cases, the CSM
monitors and determines what reference to use at a given time.

Follow the procedure in Table 3-16 to enable the CSMs.

Table 3-16: Enable CSMs

n Step Action

1 Click on the target CSM (CSM–2 first, if equipped with two CSMs).

2 From the Device pull down, select Enable.

– A status report is displayed confirming change in the device(s) status.

– Click OK to close the status report window.

NOTE
– The board in slot CSM 1 interfaces with the GPS receiver. The enable sequence for this board can

take up to one hour (see below).

– FAIL may be shown in the status report table for a slot CSM 1 enable action. If Waiting For Phase
Lock is shown in the Description field, the CSM changes to the Enabled state after phase lock is
achieved.

* IMPORTANT
– The GPS satellite system satellites are not in a geosynchronous orbit and are maintained and

operated by the United States Department of Defense (D.O.D.). The D.O.D. periodically alters
satellite orbits; therefore, satellite trajectories are subject to change. A GPS receiver that is INS
contains an “almanac” that is updated periodically to take these changes into account.

– If a GPS receiver has not been updated for a number of weeks, it may take up to an hour for the
GPS receiver “almanac” to be updated.

– Once updated, the GPS receiver must track at least four satellites and obtain (hold) a 3–D position
fix for a minimum of 45 seconds before the CSM will come in service. (In some cases, the GPS
receiver needs to track only one satellite, depending on accuracy mode set during the data load).

. . . continued on next page
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Table 3-16: Enable CSMs

n ActionStep

NOTE
– If equipped with two CSMs, CSM–1 should be bright green (INS–ACT) and CSM–2 should be

dark green (INS–STY)

– After the CSMs have been successfully enabled, observe the PWR/ALM LEDs are steady green
(alternating green/red indicates the card is in an alarm state).

3 If more than an hour has passed, refer to CSM Verification, see Figure 3-11 and Table 3-20 to
determine the cause.

 

Enable MCCs

Follow the procedure in Table 3-17 to enable the MCCs.

NOTE The MGLI and primary CSM must be downloaded and enabled
(IN–SERVICE ACTIVE) before downloading and enabling the
MCC.

Table 3-17: Enable MCCs

n Step Action

1 Select the MCCs to be enabled or from the Select pull–down menu
choose MCCs.

2 Click on Device in the BTS menu bar, and select Enable in the
pull–down menu list.

– A status report is displayed showing the  results of the enable
operation.

3 Click on OK to close the status report window.
 

Enable Redundant GLIs

Follow the procedure in Table 3-18 to enable the redundant GLI(s).

Table 3-18: Enable Redundant GLIs

n Step Action

1 Select the target redundant GLI(s).

2 From the Device menu, select Enable.

– A status report window confirms the change in the device(s)
status and the enabled GLI(s) is green.

3 Click on OK to close the status report window.
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CSM System Time – GPS & LFR/HSO Verification

CSM & LFR Background

The primary function of the Clock Synchronization Manager (CSM)
boards (slots 1 and 2) is to maintain CDMA system time. The CSM in
slot 1 is the primary timing source while slot 2 provides redundancy. The
CSM2 card (CSM second generation) is required when using the remote
GPS receiver (R–GPS). R–GPS uses a GPS receiver in the antenna head
that has a digital output to the CSM2 card. CSM2 can have a daughter
card as a local GPS receiver to support an RF–GPS signal.

The CSM2 switches between the primary and redundant units (slots 1
and 2) upon failure or command. CDMA Clock Distribution
Cards (CCDs) buffer and distribute even–second reference and 19.6608
MHz clocks. CCD–1 is married to CSM–1 and CCD–2 is married to
CSM 2. A failure on CSM–1 or CCD–1 cause the system to switch to
redundant CSM–2 and CCD–2.

In a typical operation, the primary CSM locks its Digital Phase Locked
Loop (DPLL) circuits to GPS signals. These signals are generated by
either an on–board GPS module (RF–GPS) or a remote GPS receiver
(R–GPS). The CSM2 card is required when using the R–GPS. DPLL
circuits employed by the CSM provide switching between the primary
and redundant unit upon request. Synchronization between the primary
and redundant CSM cards, as well as the LFR or HSO back–up source,
provides excellent reliability and performance.

Each CSM board features an ovenized, crystal oscillator that provides
19.6608 MHz clock, even second tick reference, and 3 MHz sinewave
reference, referenced to the selected synchronization source (GPS,
LORAN–C Frequency Receiver (LFR), or High Stability Oscillator
(HSO), T1 Span, or external reference oscillator sources).

The 3 MHz signals are also routed to the RDM EXP 1A & 1B
connectors on the top interconnect panel for distribution to co–located
frames at the site.

Fault management has the capability of switching between the GPS
synchronization source and the LFR/HSO backup source in the event of
a GPS receiver failure on CSM–1. During normal operation, the CSM–1
board selects GPS as the primary source (see Table 3-20). The source
selection can also be overridden via the LMF or by the system software.

Front Panel LEDs

The status of the LEDs on the CSM boards are as follows:

S Steady Green – Master CSM locked to GPS or LFR (INS).

S Rapidly Flashing Green – Standby CSM locked to GPS or LFR
(STBY).

S Flashing Green/Rapidly Flashing Red – CSM OOS–RAM attempting
to lock on GPS signal.

S Rapidly Flashing Green and Red – Alarm condition exists. Trouble
Notifications (TNs) are currently being reported to the GLI.
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Low Frequency Receiver/High Stability Oscillator (LFR/HSO)

The CSM and the LFR/HSO – The CSM performs the overall
configuration and status monitoring functions for the LFR/HSO. In the
event of GPS failure, the LFR/HSO is capable of maintaining
synchronization initially established by the GPS reference signal.

LFR – The LFR requires an active external antenna to receive
LORAN–C RF signals. Timing pulses are derived from this signal,
which is synchronized to Universal Time Coordinates (UTC) and GPS
time. The LFR can maintain system time indefinitely after initial GPS
lock.

HSO – The HSO is a high stability 10 MHz oscillator with the necessary
interface to the CSMs. The HSO is typically installed in those
geographical areas not covered by the LORAN–C system. Since the
HSO is a free–standing oscillator, system time can only be maintained
for 24 hours after 24 hours of GPS lock

Upgrades and Expansions: LFR2/HSO2/HSOX

LFR2/HSO2 (second generation cards) both export a timing signal to the
expansion or logical BTS frames. The associated expansion or logical
frames require an HSO–expansion (HSOX) whether the starter frame has
an LFR2 or an HSO2. The HSOX accepts input from the starter frame
and interfaces with the CSM cards in the expansion frame. LFR and
LFR2 use the same source code in source selection (see Table 3-19).
HSO, HSO2, and HSOX use the same source code in source selection
(see Table 3-19).

NOTE Allow the base site and test equipment to warm up for 60
minutes after any interruption in oscillator power. CSM board
warm-up allows the oscillator oven temperature and oscillator
frequency to stabilize prior to test. Test equipment warm-up
allows the Rubidium standard timebase to stabilize in frequency
before any measurements are made.
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CSM Frequency Verification

The objective of this procedure is the initial verification of the CSM
boards before performing the RF path verification tests. Parts of this
procedure will be repeated for final verification after the overall
optimization has been completed.

Null Modem Cable
A null modem cable is required. It is connected between the MMI port
of the primary CSM and the null modem board. Figure 3-10 shows the
wiring detail for the null modem cable.

Figure 3-10: Null Modem Cable Detail
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Prerequisites

Ensure the following prerequisites have been met before proceeding:

S The LMF is NOT logged into the BTS.

S The COM1 port is connected to the MMI port of the primary CSM via
a null modem board.
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Test Equipment Setup: GPS & LFR/HSO Verification

Follow the procedure in Table 3-19 to set up test equipment while
referring to Figure 3-11 as required.

Table 3-19: Test Equipment Setup (GPS & LFR/HSO Verification)

Step Action

1 Perform one of the following operations:

S For local GPS (RF–GPS), verify a CSM board with a GPS receiver is installed in primary CSM
slot 1 and that CSM–1 is INS.
This is verified by checking the board ejectors for kit number SGLN1145 on the board in slot 1.

S For Remote GPS (RGPS), verify a CSM2 board is installed in primary slot 1 and that CSM–1 is
INS.
This is verified by checking the board ejectors for kit number SGLN4132ED (or later).

2 Remove CSM–2 (if installed) and connect a serial cable from the LMF COM 1 port (via null modem
board) to the MMI port on CSM–1.

3 Reinstall CSM–2.

4 Start an MMI communication session with CSM–1 by using the Windows desktop shortcut icon (see
Table 3-3)

NOTE
The LMF program must not be running when a Hyperterminal session is started if COM1 is being
used for the MMI session.

5 When the terminal screen appears, press the <Enter> key until the CSM> prompt appears.

 

3



CSM System Time – GPS & LFR/HSO Verification68P09258A31–A

Oct 2003 1X SCt 4812T BTS Optimization/ATP 3-47

Figure 3-11: CSM MMI terminal connection
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GPS Initialization/Verification

Follow the procedure in Table 3-20 to initialize and verify proper GPS
receiver operation.

Prerequisites

Ensure the following prerequisites have been met before proceeding:

S The LMF is not logged into the BTS.

S The COM1 port is connected to the MMI port of the primary CSM via
a null modem board (see Figure 3-11).

S The primary CSM and HSO (if equipped) have been warmed up for at
least 15 minutes.

CAUTION Connect the GPS antenna to the GPS RF connector ONLY.
Damage to the GPS antenna and/or receiver can result if the
GPS antenna is inadvertently connected to any other RF
connector.
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Table 3-20: GPS Initialization/Verification

Step Action

1 To verify that Clock alarms (0000), Dpll is locked and has a reference source, and
GPS self test passed messages are displayed within the report, issue the following MMI
command

bstatus

– Observe the following typical response:

Clock Alarms (0000):

DPLL is locked and has a reference source.
GPS receiver self test result: passed

Time since reset 0:33:11, time since power on: 0:33:11

2 Enter the following command at the CSM> prompt to display the current status of the Loran and the
GPS receivers.

sources

– Observe the following typical response for systems equipped with LFR:

N Source Name Type TO Good Status Last Phase Target Phase Valid
–––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––
0 LocalGPS Primary 4 YES Good 0 0 Yes
1 LFR CHA Secondary 4 YES Good –2013177 –2013177 Yes
2 Not Used
Current reference source number: 0

– Observe the following typical response for systems equipped with HSO:

Num Source Name Type TO Good Status Last Phase Target Phase Valid
––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––
0 Local GPS Primary 4 Yes Good 3 0 Yes
1 HSO Backup 4 No N/A timed–out* Timed–out* No

NOTE
“Timed–out” should only be displayed while the HSO is warming up.  “Not–Present” or “Faulty”
should not be displayed.  If the HSO does not appear as one of the sources, then configure the HSO as
a back–up source by entering the following command at the CSM> prompt:

ss 1 12

After a maximum of 15 minutes, the Rubidium oscillator should reach operational temperature and the
LED on the HSO should now have changed from red to green.  After the HSO front panel LED has
changed to green, enter sources <cr> at the CSM> prompt.  Verify that the HSO is now a valid
source by confirming that the bold text below matches the response of the “sources” command.

The HSO should be valid within one (1) minute, assuming the DPLL is locked and the HSO rubidium
oscillator is fully warmed.

Num Source Name Type TO Good Status Last Phase Target Phase Valid
––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––
0 Local GPS Primary 4 Yes Good 3 0 Yes
1 HSO Backup 4 Yes N/A xxxxxxxxxx xxxxxxxxxx Yes

3 HSO information (underlined text above, verified from left to right) is usually the #1 reference source.
If this is not the case, have the OMCR determine the correct BTS timing source has been identified in
the database by entering the display bts csmgen command and correct as required using the edit
csm csmgen refsrc command.

. . . continued on next page
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Table 3-20: GPS Initialization/Verification

Step Action

4 If any of the above mentioned areas fail, verify:

– If LED is RED, verify that HSO had been powered up for at least 5 minutes. After oscillator
temperature is stable, LED should go GREEN Wait for this to occur before continuing !

– If “timed out” is displayed in the Last Phase column, suspect the HSO output buffer or oscillator
is defective

– Verify the HSO is FULLY SEATED and LOCKED to prevent any possible board warpage

5 Verify the following GPS information (underlined text above):

– GPS information is usually the 0 reference source.

– At least one Primary source must indicate “Status = good” and “Valid = yes” to bring site up.

6 Enter the following command at the CSM> prompt to verify that the GPS receiver is in tracking mode.

gstatus

– Observe the following typical response:

24:06:08 GPS Receiver Control Task State: tracking satellites.
24:06:08 Time since last valid fix: 0 seconds.
24:06:08 
24:06:08 Recent Change Data:
24:06:08 Antenna cable delay 0 ns.
24:06:08 Initial position: lat 117650000 msec, lon –350258000 msec, height 0 cm (GPS)
24:06:08 Initial position accuracy (0): estimated.
24:06:08 
24:06:08 GPS Receiver Status:
24:06:08 Position hold:  lat 118245548 msec, lon –350249750 msec, height 20270 cm
24:06:08 Current position: lat 118245548 msec, lon –350249750 msec, height 20270 cm
(GPS)
24:06:08 8 satellites tracked, receiving 8 satellites, 8 satellites visible.
24:06:08 Current Dilution of Precision (PDOP or HDOP): 0.
24:06:08 Date & Time: 1998:01:13:21:36:11
24:06:08 GPS Receiver Status Byte: 0x08
24:06:08 Chan:0, SVID: 16, Mode: 8, RSSI: 148, Status: 0xa8
24:06:08 Chan:1, SVID: 29, Mode: 8, RSSI: 132, Status: 0xa8
24:06:08 Chan:2, SVID: 18, Mode: 8, RSSI: 121, Status: 0xa8
24:06:08 Chan:3, SVID: 14, Mode: 8, RSSI: 110, Status: 0xa8
24:06:08 Chan:4, SVID: 25, Mode: 8, RSSI:  83, Status: 0xa8
24:06:08 Chan:5, SVID:  3, Mode: 8, RSSI:  49, Status: 0xa8
24:06:08 Chan:6, SVID: 19, Mode: 8, RSSI: 115, Status: 0xa8
24:06:08 Chan:7, SVID: 22, Mode: 8, RSSI: 122, Status: 0xa8
24:06:08 
24:06:08 GPS Receiver Identification:
24:06:08 COPYRIGHT 1991–1996 MOTOROLA INC. 
24:06:08 SFTW P/N # 98–P36830P      
24:06:08 SOFTWARE VER # 8           
24:06:08 SOFTWARE REV # 8           
24:06:08 SOFTWARE DATE  6 AUG 1996 
24:06:08 MODEL #    B3121P1115      
24:06:08 HDWR P/N # _               
24:06:08 SERIAL #   SSG0217769      
24:06:08 MANUFACTUR DATE 6B07       
24:06:08 OPTIONS LIST    IB        
24:06:08 The receiver has 8 channels and is equipped with TRAIM.

. . . continued on next page
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Table 3-20: GPS Initialization/Verification

Step Action

7 Verify the following GPS information (shown above in underlined text):

– At least 4 satellites are tracked, and 4 satellites are visible.

– GPS Receiver Control Task State is “tracking satellites”. Do not continue until this occurs!

– Dilution of Precision indication is not more that 30.

Record the current position base site latitude, longitude, height and height reference (height reference
to Mean Sea Level (MSL) or GPS height (GPS).  (GPS = 0   MSL = 1).

8 If steps 1 through 7 pass, the GPS is good.

NOTE
If any of the above mentioned areas fail, verify that:

– If Initial position accuracy is “estimated” (typical), at least 4 satellites must be tracked and
visible (1 satellite must be  tracked and visible if actual lat, log, and height data for this site has
been entered into CDF file).

– If Initial position accuracy is “surveyed”, position data currently in the CDF file is assumed to be
accurate. GPS will not automatically survey and update its position.

– The GPS antenna is not obstructed or misaligned.

– GPS antenna connector center conductor measures approximately +5 Vdc with respect to the
shield.

– There is no more than 4.5 dB of loss between the GPS antenna OSX connector and the BTS frame
GPS input.

– Any lightning protection installed between GPS antenna and BTS frame is installed correctly.

9 Enter the following commands at the CSM> prompt to verify that the CSM is warmed up and that GPS
acquisition has taken place.

debug dpllp 

Observe the following typical response if the CSM is not warmed up (15 minutes from application of
power)  (If warmed–up proceed to step 10)

CSM>DPLL Task Wait. 884 seconds left.
DPLL Task Wait. 882 seconds left.
DPLL Task Wait. 880 seconds left.   ...........etc.

NOTE
The warm command can be issued at the MMI port used to force the CSM into warm–up, but the
reference oscillator will be unstable.

. . . continued on next page
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Table 3-20: GPS Initialization/Verification

Step Action

10 Observe the following typical response if the CSM is warmed up.

c:17486 off: –11, 3, 6 TK SRC:0 S0: 3 S1:–2013175,–2013175
c:17486 off: –11, 3, 6 TK SRC:0 S0: 3 S1:–2013175,–2013175
c:17470 off: –11, 1, 6 TK SRC:0 S0: 1 S1:–2013175,–2013175
c:17486 off: –11, 3, 6 TK SRC:0 S0: 3 S1:–2013175,–2013175
c:17470 off: –11, 1, 6 TK SRC:0 S0: 1 S1:–2013175,–2013175
c:17470 off: –11, 1, 6 TK SRC:0 S0: 1 S1:–2013175,–2013175

11 Verify the following GPS information (underlined text above, from left to right):

– Lower limit offset from tracked source variable is not less than –60 (equates to 3µs limit).

– Upper limit offset from tracked source variable is not more than +60 (equates to 3µs limit).

– TK SRC: 0 is selected, where SRC 0 = GPS.

12 Enter the following commands at the CSM> prompt to exit the debug mode display.

debug dpllp

 

LFR Initialization/Verification
The LORAN–C LFR is a full size card that resides in the C–CCP Shelf.
The LFR is a completely self-contained unit that interfaces with the
CSM via a serial communications link. The CSM handles the overall
configuration and status monitoring functions of the LFR.

The LFR receives a 100 kHz, 35 kHz BW signal from up to 40 stations
(8 chains) simultaneously and provides the following major functions:

S Automatic antenna pre-amplifier calibration (using a second
differential pair between LFR and LFR antenna)

S A 1 second ±200 ηs strobe to the CSM

If the BTS is equipped with an LFR, follow the procedure in Table 3-21
to initialize the LFR and verify proper operation as a backup source for
the GPS.

NOTE If CSMRefSrc2 = 2 in the CDF file, the BTS is equipped with
an LFR. If CSMRefSrc2 = 18, the BTS is equipped with an
HSO.
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Table 3-21: LFR Initialization/Verification

Step Action Note

1 At the CSM> prompt, enter lstatus <cr> to verify that the LFR is in tracking
mode. A typical response is:mode. A typical response is:

CSM> lstatus <cr>
LFR St ti  St tLFR Station Status:
Clock coherence: 512 >
5930M 51/60 dB 0 S/N Flag:
5930X 52/64 dn –1 S/N Flag:
5990 47/55 dB –6 S/N Flag:
7980M 62/66 dB 10 S/N Fl

This must be greater
than 100 before LFR
becomes a valid source.

7980M 62/66 dB 10 S/N Flag:
7980W 65/69 dB 14 S/N Flag: . PLL Station . >
7980X 48/54 dB –4 S/N Flag:
7980Y 46/58 dB –8 S/N Flag:E
7980Z 60/67 dB 8 S/N Flag:
8290M 50/65 dB 0 S/N Flag:

This shows the LFR is
locked to the selected
PLL station.

8290M 50/65 dB 0 S/N Flag:
8290W 73/79 dB 20 S/N Flag:
8290W 58/61 dB 6 S/N Flag:8290W 58/61 dB 6 S/N Flag:
8970M 89/95 dB 29 S/N Flag:
8970W 62/66 dB 10 S/N Flag:
8970X 73/79 dB 22 S/N Flag:8970X 73/79 dB 22 S/N Flag:
8970Y 73/79 dB 19 S/N Flag:
8970Z 62/65 dB 10 S/N Flag:
9610M 62/65 dB 10 S/N Fl

g
9610M 62/65 dB 10 S/N Flag:
9610V 58/61 dB 8 S/N Flag:
9610W 47/49 dB –4 S/N Flag:E9610W 47/49 dB –4 S/N Flag:E
9610X 46/57 dB –5 S/N Flag:E
9610Y 48/54 dB –5 S/N Flag:E
9610Z 65/69 dB 12 S/N Flag:9610Z 65/69 dB 12 S/N Flag:
9940M 50/53 dB –1 S/N Flag:S
9940W 49/56 dB –4 S/N Flag:E9940W 49/56 dB 4 S/N Flag:E
9940Y 46/50 dB–10 S/N Flag:E
9960M 73/79 dB 22 S/N Flag:
9960W 51/60 dB 0 S/N Flag:9960W 51/60 dB 0 S/N Flag:
9960X 51/63 dB –1 S/N Flag:
9960Y 59/67 dB 8 S/N Flag:
9960Z 89/96 dB 29 S/N Fl9960Z 89/96 dB 29 S/N Flag:

LFR Task State: lfr locked to station 7980W
LFR Recent Change Data:

Search List: 5930 5990 7980 8290 8970 9940 9610 9960 >
PLL GRI: 7980W

LFR Master, reset not needed, not the reference source.
CSM>

This search list and PLL
data must match the
configuration for the
geographical location
of the cell site.

2 Verify the following LFR information (highlighted above in boldface type):

– Locate the “dot” that indicates the current phase locked station assignment (assigned by MM).

– Verify that the station call letters are as specified in site documentation as well as M X Y Z
assignment.

– Verify the signal to noise (S/N) ratio of the phase locked station is greater than 8.

3 At the CSM> prompt, enter sources <cr> to display the current status of the the LORAN receiver.

– Observe the following typical response.

Num Source Name Type TO Good Status Last Phase Target Phase Valid
––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––
0 Local GPS Primary 4 Yes Good –3 0 Yes
1 LFR ch A Secondary 4 Yes Good –2013177 –2013177 Yes
2 Not used
Current reference source number: 1

. . . continued on next page
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Table 3-21: LFR Initialization/Verification

Step NoteAction

4 LORAN–C LFR information (highlighted above in boldface type) is usually the #1 reference source
(verified from left to right).

NOTE
If any of the above mentioned areas fail, verify:

– The LFR antenna is not obstructed or misaligned.

– The antenna pre–amplifier power and calibration twisted pair connections are intact and < 91.4 m
(300 ft) in length.

– A dependable connection to suitable Earth Ground is in place.

– The search list and PLL station for cellsite location are correctly configured .

NOTE
LFR functionality should be verified using the “source” command (as shown in Step 3). Use the
underlined responses on the LFR row to validate correct LFR operation.

5 Close the Hyperterminal window.

 

HSO Initialization/Verification

The HSO module is a full–size card that resides in the C–CCP Shelf.
This completely self contained high stability 10 MHz oscillator
interfaces with the CSM via a serial communications link. The CSM
handles the overall configuration and status monitoring functions of the
HSO. In the event of GPS failure, the HSO is capable of maintaining
synchronization initially established by the GPS reference signal for a
limited time.

The HSO is typically installed in those geographical areas not covered
by the LORAN–C system and provides the following major functions:

S Reference oscillator temperature and phase lock monitor circuitry

S Generates a highly stable 10 MHz sine wave.

S Reference divider circuitry converts 10 MHz sine wave to 10 MHz
TTL signal, which is divided to provide a 1 PPS strobe to the CSM.
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Prerequisites
S The LMF is not logged into the BTS.

S The COM1 port is connected to the MMI port of the primary CSM via
a null modem board.

S The primary CSM and the HSO (if equipped) have warmed up for 15
minutes.

If the BTS is equipped with an HSO, follow the procedure in Table 3-22
to configure the HSO.

Table 3-22: HSO Initialization/Verification

Step Action

1 At the BTS, slide the HSO card into the cage.

NOTE
The LED on the HSO should light red for no longer than 15-minutes, then switch to green. The CSM
must be locked to GPS.

2 On the LMF at the CSM> prompt, enter sources <cr>.

– Observe the following typical response for systems equipped with HSO:

Num Source Name Type TO Good Status Last Phase Target Phase Valid
––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––
0 Local GPS Primary 4 Yes Good 0 0 Yes
1 HSO Backup 4 Yes N/A xxxxxxx –69532 Yes
2 Not used
Current reference source number: 0

When the CSM is locked to GPS, verify that the HSO “Good” field is Yes and the “Valid” field is Yes.

3 If source “1” is not configured as HSO, enter at the CSM> prompt: ss 1 12 <cr>

Check for Good in the Status field.

4 At the CSM> prompt, enter sources <cr>.

Verify the HSO valid field is Yes. If not, repeat this step until the “Valid” status of Yes is returned. The
HSO should be valid within one (1) minute, assuming the DPLL is locked and the HSO Rubidium
oscillator is fully warmed.
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Test Equipment Set-up

Connecting Test Equipment to the BTS
The following equipment is required to perform optimization:

S LMF

S Test set

S Directional coupler and attenuator

S RF cables and connectors

S Null modem cable (see Figure 3-10)

S GPIB interface box

Refer to Table 3-23 and Table 3-24 for an overview of connections for
test equipment currently supported by the LMF. In addition, see the
following figures:

S Figure 3-16 and Figure 3-17 show the test set connections for TX
calibration.

S Figure 3-19 and Figure 3-20 show test set connections for IS–95 A/B
optimization/ATP tests.

S Figure 3-21 shows test set connections for IS–95 A/B and
CDMA 2000 optimization/ATP tests.

S Figure 3-23 and Figure 3-24 show typical TX and RX ATP setup with
a directional coupler (shown with and without RFDS).

Test Equipment GPIB Address Settings

All test equipment is controlled by the LMF through an IEEE–488/GPIB
bus. To communicate on the bus, each piece of test equipment must have
a GPIB address set which the LMF will recognize. The standard address
settings used by the LMF for the various types of test equipment items
are as follows:

S Signal generator address:  1

S Power meter address:  13

S Communications system analyzer:  18

Using the procedures included in the Verifying and Setting GPIB
Addresses section of Appendix F, verify and, if necessary, change the
GPIB address of each piece of employed test equipment to match the
applicable addresses above.
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Supported Test Equipment

CAUTION To prevent damage to the test equipment, all TX test connections
must be through the directional coupler and in-line attenuator as
shown in the test setup illustrations.

IS–95 A/B Testing
Optimization and ATP testing for IS–95A/B may be performed using
one of the following test sets:

S CyberTest

S Advantest R3465 and HP 437B or Gigatronics Power Meter

S Hewlett–Packard HP 8935

S Hewlett–Packard HP 8921 (W/CDMA and PCS Interface for
1.7/1.9 GHz) and HP 437B or Gigatronics Power Meter

The equipment listed above cannot be used for  CDMA 2000 testing.

CDMA2000 1X Operation
Optimization and ATP testing for CDMA2000 1X sites or carriers may
be performed using the following test equipment:

S Advantest R3267 Analyzer with Advantest R3562 Signal Generator

S Agilent E4406A with E4432B Signal Generator

S Agilent 8935 series E6380A communications test set (formerly HP
8935) with option 200 or R2K and with E4432B signal generator for
1X FER

The E4406A/E4432B pair, or the R3267/R3562 pair, should be
connected together using a GPIB cable. In addition, the R3562 and
R3267 should be connected with a serial cable from the Serial I/O to the
Serial I/O. This test equipment is capable of performing tests in both
IS–95 A/B mode and CDMA 2000 mode if the required options are
installed.

S Agilent E7495A communications test set

Optional test equipment
S Spectrum Analyzer (HP8594E) – can be used to perform cable

calibration.

Test Equipment Preparation

See Appendix F for specific steps to prepare each type of test set and
power meter to perform calibration and ATP.

Agilent E7495A communications test set requires additional setup and
preparation. This is described in detail in Appendix F.
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Test Equipment Connection Charts

To use the following charts to identify necessary test equipment
connections, locate the communications system analyzer being used in
the COMMUNICATIONS SYSTEM ANALYZER columns, and read down
the column. Where a dot appears in the column, connect one end of the
test cable to that connector. Follow the horizontal line to locate the end
connection(s), reading up the column to identify the appropriate
equipment and/or BTS connector.

IS–95A/B–only Test Equipment Connections

Table 3-23 depicts the interconnection requirements for currently
available test equipment supporting IS–95A/B only which meets
Motorola standards and is supported by the LMF.

Table 3-23: IS–95 A/B Test Equipment Setup
COMMUNICATIONS SYSTEM ANALYZER ADDITIONAL TEST EQUIPMENT

SIGNAL
Cyber–

Test

Advant-
est

R3465
HP

8935
HP

8921A
HP 8921
W/PCS

Power
Meter

GPIB
Inter-
face LMF

30 dB Direction-
al Coupler & 20

dB Pad* BTS

EVEN SECOND 
SYNCHRONIZATION

EVEN
SEC
REF

EVEN SEC
SYNC IN

EVEN
SECOND
SYNC IN

EVEN
SECOND
SYNC IN

EVEN
SECOND
SYNC IN

19.6608 MHZ
CLOCK TIME

BASE IN

CDMA
TIME BASE

IN
EXT

REF IN

CDMA
TIME

BASE IN

CDMA
TIME

BASE IN

CONTROL
IEEE 488 BUS

IEEE
488 GPIB HP–IB HP–IB GPIB

SERIAL
PORTHP–IB HP–IB

TX TEST
CABLES

RF
IN/OUT

INPUT
50–OHM

RF
IN/OUT TX1–6

RF
IN/OUT

RF
IN/OUT

30 DB COUPLER
AND 20 DB PAD

RX TEST
CABLES

RF GEN
OUT

RF OUT
50–OHM RX1–6

DUPLEX
OUT

RF OUT
ONLY

SYNC
MONITOR

FREQ
MONITOR

RF
IN/OUT
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CDMA2000 1X/IS–95A/B–capable Test Equipment
Connections
Table 3-24 depicts the interconnection requirements for currently
available test equipment supporting both CDMA 2000 1X and
IS–95A/B which meets Motorola standards and is supported by the
LMF.

Table 3-24: CDMA2000 1X/IS–95A/B Test Equipment Interconnection
COMMUNICATIONS SYSTEM ANALYZER ADDITIONAL TEST EQUIPMENT

SIGNAL

Agilent
8935 (Op-
tion 200 
or R2K)

Agilent
E7495A

Advan
test

R3267
Agilent
E4406A

Agilent
E4432B
Signal

Generator

Advant-
est

R3562
Signal

Genera-
tor

Power
Meter

GPIB
Inter-
face LMF

30 dB
Directional
Coupler &
20 dB Pad* BTS

EVEN SECOND 
SYNCHRONIZATION

EXT
TRIG  IN

EXT 
TRIG

TRIGGER 
IN

19.6608 MHZ
CLOCK

MOD TIME
BASE IN

EXT REF
IN

CONTROL
IEEE 488 BUS

IEEE
488 GPIB HP–IB GPIB

SERIAL
PORTHP–IB

TX TEST
CABLES

RF
IN/OUT RF IN TX1–6

RF INPUT
50 OHM

30 DB COUPLER
AND 20 DB PAD

RX TEST
CABLES

RF OUT
50 OHM

RF OUT
50–OHM RX1–6

RF OUT
ONLY

SYNC
MONI
TOR

FREQ
MONITOR

PATTERN
TRIG  IN

GPIB

RF OUTPUT
50 OHM

RF OUTPUT
50–OHM

10 MHZ IN
10 MHZ OUT
(SWITCHED) 10 MHZ IN

10 MHZ
OUT10 MHZ

SERIAL
I/O

SERIAL
I/OSIGNAL SOURCE

CONTROLLED
SERIAL I/O

EVEN
SECOND
SYNC  IN

EXT REF
IN

HP–IB

RF IN/OUT

DUPLEX
OUT *

SYNTHE
REF IN

*  WHEN USED ALONE, THE AGILENT 8935 WITH OPTION 200 OR R2K SUPPORTS IS–95A/B RX TESTING BUT NOT CDMA2000 1X RX TESTING.

EVEN
SECOND
SYNC  IN

PORT 1
RF OUT

PORT 2
RF IN
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Equipment Warm-up

NOTE To assure BTS stability and contribute to optimization accuracy
of the BTS, warm-up the BTS test equipment prior to
performing the BTS optimization procedure as follows:

– Agilent E7495A for a minimum of 30 minutes

– All other test sets for a minimum of 60 minutes
Time spent running initial or normal power-up, hardware/
firmware audit, and BTS download counts as warm-up time.

WARNING Before installing any test equipment directly to any BTS TX
OUT connector, verify there are no CDMA channels keyed.

– At active sites, have the OMC-R/CBSC place the antenna
(sector) assigned to the LPA under test OOS. Failure to do
so can result in serious personal injury and/or equipment
damage.

Automatic Cable Calibration Set–up
Figure 3-12 through Figure 3-15 show the cable calibration setup for
various supported test sets. The left side of the diagram depicts the
location of the input and output ports of each test set, and the right side
details the set up for each test.

Manual Cable Calibration

If manual cable calibration is required, refer to the procedures in
Appendix F.
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Figure 3-12: IS–95A/B Cable Calibration Test Setup – 
CyberTest, Agilent 8935, Advantest R3465, and HP 8921A

ÎÎÎ
ÎÎÎÏ

ÁÁÁÁ
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ÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Motorola CyberTest

Agilent 8935 Series E6380A
(formerly HP 8935)

Advantest Model R3465

DUPLEX
OUT

RF OUTPUT
50–OHM

RF INPUT
50–OHM

RF GEN OUTANT IN

ANT
IN

SUPPORTED TEST SETS

100–WATT  (MIN)
NON–RADIATING

RF LOAD

TEST
SET

A. SHORT CABLE CAL

SHORT
CABLE

B. RX TEST SETUP

TEST
SET

C. TX TEST SETUP

20 DB PAD
FOR 1.9 GHZ

CALIBRATION SET UP

N–N FEMALE
ADAPTER

TX
CABLE

TX
CABLE

SHORT
CABLE

Note: The Directional Coupler is not used with the
Cybertest Test Set. The TX cable is connected
directly to the Cybertest Test Set.

A 10dB attenuator must be used with the short test
cable for cable calibration with the CyberTest Test
Set. The 10dB attenuator is used only for the cable
calibration procedure, not with the test cables for
TX calibration and ATP tests.

TEST
SET

RX
CABLE

SHORT
CABLE

FW00089

Note: For 800 MHZ only. The HP8921A cannot
be used to calibrate cables for PCS frequencies.

Hewlett–Packard Model HP 8921A
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Figure 3-13: IS–95A/B and CDMA 2000 1X Cable Calibration Test Setup –
Agilent E4406A/E4432B and Advantest R3267/R3562
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Figure 3-14: CDMA2000 1X Cable Calibration Test Setup – Agilent 8935/E4432B
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Figure 3-15: CDMA2000 1X Cable Calibration Test Setup –  Agilent E7495A
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Set-up for TX Calibration
Figure 3-16 through Figure 3-18 show the test set connections for TX
calibration.

Figure 3-16: TX Calibration Test Setup – CyberTest (IS–95A/B) and 
Agilent 8935 (IS–95A/B and CDMA2000 1X), and Advantest R3465
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Figure 3-17: TX Calibration Test Setup – 
Agilent E4406A and Advantest R3567 (IS–95A/B and CDMA2000 1X)
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Figure 3-18: TX Calibration Test Setup – Agilent E7495A (IS–95A/B and CDMA2000 1X)
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Setup for Optimization/ATP
Figure 3-19 and Figure 3-21 show test set connections for IS–95 A/B
optimization/ATP tests. Figure 3-21 and Figure 3-22 show test set
connections for IS-95 A/B/C optimization/ATP tests.

Figure 3-19: Optimization/ATP Test Setup Calibration – Agilent 8935

ÁÁÁÁÁÁÁÁ
ÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁ

TEST SET Optimization/ATP SET UP

RF IN/OUT

HP–IB
TO GPIB
BOX

SYNC MONITOR
EVEN SEC TICK

PULSE REFERENCE
FROM CSM BOARD

FREQ MONITOR
19.6608 MHZ CLOCK
REFERENCE FROM
CSM BOARD

RX ANTENNA
PORT OR RFDS

RX DIRECTIONAL
COUPLER

ANTENNA PORT

TX ANTENNA
PORT OR RFDS

TX DIRECTIONAL
COUPLER

ANTENNA PORT

RS232 NULL
MODEM
CABLE

BTS

TX
TEST
CABLE

10BASET/
10BASE2
CONVERTER

LAN
B

LAN
A

RX
TEST
CABLE

COMMUNICATIONS
TEST SET

IEEE 488
GPIB BUS

RF
IN/OUT

TEST SET
INPUT/

OUTPUT
PORTS

NOTE:  IF BTS RX/TX SIGNALS ARE
DUPLEXED (4800E): BOTH THE TX AND RX
TEST CABLES CONNECT TO THE DUPLEXED
ANTENNA GROUP.

100–WATT (MIN)
NON–RADIATING

RF LOAD

2O DB PAD FOR 1.7/1.9 GHZ
(10 DB PAD FOR 800 MHZ)

EVEN
SECOND/SYNC
IN

CDMA
TIMEBASE

 IN

FREQ
MONITOR

SYNC
MONITOR

CSM

30 DB
DIRECTIONAL
COUPLER

RS232–GPIB
INTERFACE BOX

S MODE
DATA FORMAT

BAUD RATE

GPIB ADRS G MODE

ON

DIP SWITCH SETTINGS

INTERNAL PCMCIA
ETHERNET CARD

UNIVERSAL TWISTED
PAIR (UTP) CABLE

(RJ45 CONNECTORS)

CDMA
LMF

REF FW00096

Agilent 8935 Series E6380A (formerly HP 8935)

3



Test Equipment Set-up68P09258A31–A

Oct 2003 1X SCt 4812T BTS Optimization/ATP 3-69

Figure 3-20: Optimization/ATP Test Setup – HP 8921
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Figure 3-21: IS–95A/B and CDMA2000 1X Optimization/ATP Test Setup – 
Advantest R3267/3562, Agilent E4432B/E4406A
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Figure 3-22: IS–95A/B and CDMA2000 1X Optimization/ATP Test Setup – 
Agilent E7495A
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ATP Setup with Directional Couplers

Figure 3-23 shows a typical TX ATP setup.

Figure 3-23: Typical TX ATP Setup with Directional Coupler
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Figure 3-24: Typical RX ATP Setup with Directional Coupler
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Test Set Calibration

Background
Proper test equipment calibration ensures that the test equipment and
associated test cables do not introduce measurement errors, and that
measurements are correct.

NOTE If the test equipment set being used to optimize or test the BTS
has been calibrated and maintained as a set, this procedure does
not need to be performed.

This procedure must be performed prior to beginning the optimization.
Verify all test equipment (including all associated test cables and
adapters actually used to interface all test equipment and the BTS) has
been calibrated and maintained as a set.

CAUTION If any piece of test equipment, test cable, or RF adapter that
makes up the calibrated test equipment set has been replaced, the
set must be re-calibrated. Failure to do so can introduce
measurement errors, resulting in incorrect measurements and
degradation to system performance. Motorola recommends
repeating cable calibration before testing at each BTS site.

NOTE Calibration of the communications system analyzer (or
equivalent test equipment) must be performed at the site before
calibrating the overall test equipment set. Calibrate the test
equipment after it has been allowed to warm–up and stabilize for
a minimum of 60 minutes.

Calibration Procedures Included

Automatic

Procedures included in this section use the LMF automated calibration
routine to determine path losses of the supported communications
analyzer, power meter, associated test cables, adapters, and (if used)
antenna switch that make up the overall calibrated test equipment set.
After calibration, the gain/loss offset values are stored in a test
measurement offset file on the LMF computer.

Manual

Agilent E4406A Transmitter Tester – The E4406A does not support
the power level zeroing calibration performed by the LMF. If this
instrument is to be used for Bay Level Offset calibration and calibration
is attempted with the LMF Calibrate Test Equipment function, the
LMF will return a status window failure message stating that zeroing
power is not supported by the E4406A. Refer to the Equipment
Calibration section of Appendix F for instructions on using the
instrument’s self–alignment (calibration) function prior to performing
Bay Level Offset calibration.

Power Meters – Manual power meter calibration procedures to be
performed prior to automated calibration are included in the Equipment
Calibration section of Appendix F.
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Cable Calibration – Manual cable calibration procedures using the HP
8921A and Advantest R3465 communications system analyzers are
provided in the Manual Cable Calibration section of Appendix F, if
needed.

GPIB Addresses

GPIB addresses can range from 1 through 30. The LMF will accept any
address in that range, but the numbers entered in the LMF Options
window GPIB address box must match the addresses of the test
equipment. Motorola recommends using 1 for a CDMA signal generator,
13 for a power meter, and 18 for a communications system analyzer. To
verify and, if necessary, change the GPIB addresses of the test
equipment, refer to the Setting GPIB Addresses section of Appendix F.

IP Addresses

For the Agilent E7495A Communications Test Set, set the IP address
and complete initial setup as described in Appendix F (Specifically, see
Table F-1 on page F-3).

Selecting Test Equipment

Serial Connection and Network Connection tabs are provided in the
LMF Options window to specify the test equipment connection method.
The Serial Connection tab is used when the test equipment items are
connected directly to the LMF computer through a GPIB box (normal
setup). The Network Connection tab is used when the test equipment is
to be connected remotely via a network connection or the Agilent
E7495A Communications Test Set is used. Refer to Appendix F
(Specifically, see Table F-1 on page F-3).

Prerequisites
Ensure the following prerequisites have been met before proceeding:

S Test equipment is correctly connected and turned on.

S GPIB addresses set in the test equipment have been verified as correct
using the applicable procedures in Appendix F. (GPIB not applicable
with Agilent E7495A)

S LMF computer serial port and test equipment are connected to the
GPIB box. (GPIB not applicable with Agilent E7495A)

Selecting Test Equipment

Test equipment may be selected either manually with operator input or
automatically using the LMF autodetect feature.
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Manually Selecting Test Equipment in a Serial Connection Tab

Test equipment can be manually specified before, or after, the test
equipment is connected. The LMF does not check to see if the test
equipment is actually detected for manual specification. Follow the
procedure in Table 3-25 to select test equipment manually.

Table 3-25: Selecting Test Equipment Manually in a Serial Connection Tab

n Step Action

1 In the LMF window menu bar, click Tools and select Options... from the pull–down menu. The
LMF Options window appears.

2 Click on the Serial Connection tab (if not in the forefront).

3 Select the correct serial port in the COMM Port pick list (normally COM1).

4 Click on the Manual Specification button (if not enabled).

5 Click on the check box corresponding to the test item(s) to be used.

6 Type the GPIB address in the corresponding GPIB address box (refer to the Setting GPIB
Addresses section of Appendix F for directions on verifying and/or changing test equipment GPIB
addresses). Motorola–recommended addresses are:
1 = signal generator
13 = power meter
18 = communications system analyzer

* IMPORTANT
When test equipment items are manually selected by the operator, the LMF defaults to using a
power meter for RF power measurements. The LMF will use a communications system analyzer
for RF power measurements only if a power meter is not selected (power meter checkbox not
checked).

7 Click on Apply. (The button darkens until the selection has been committed.)

NOTE
With manual selection, the LMF does not attempt to detect the test equipment to verify it is
connected and communicating with the LMF.

To verify and, if necessary, change the GPIB address of the test equipment, refer to Appendix F.

8 Click on Dismiss to close the LMF Options window.
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Automatically Selecting Test Equipment in Serial Connection Tab

When using the auto-detection feature to select test equipment, the LMF
examines which test equipment items are actually communicating with
the LMF. Follow the procedure in Table 3-26 to use the auto-detection
feature.

Table 3-26: Selecting Test Equipment Using Auto-Detect

n Step Action

1 In the LMF window menu bar, click Tools and select Options... from the pull–down menu. The
LMF Options window appears.

2 If it is not in the forefront, click on the Serial Connection tab.

3 Select the correct serial port in the COMM Port pick list (normally COM1).

4 If it is not selected (no black dot showing), click on the Auto–Detection button.

5 If they are not already displayed in the box labeled GPIB address to search, click in the box and
type in the GPIB addresses for the test equipment to be used, separating each address with
commas and no spaces. (Refer to the Setting GPIB Addresses section of Appendix F for
instructions on verifying and/or changing test equipment GPIB addresses.)

NOTE
During the GPIB address search for a test equipment item to perform RF power measurements
(that is, for TX calibration), the LMF will select the first item it finds with the capability to
perform the measurement. If, for example, the address sequence 13,18,1 is included in the GPIB
addresses to search box, the power meter (GPIB address 13) will be used for RF power
measurements. If the address sequence 18,13,1 is included, the LMF will use the communications
system analyzer (GPIB address 18) for power measurements.

6 Click Apply.  The button will darken until the selection has been committed. A check mark will
appear in the applicable Manual Configuration section check boxes for detected test equipment
items.

7 Click Dismiss to close the LMF Options window.

 

Detecting Test Equipment when using Agilent E7495A

Check that no other equipment is connected to the LMF. Agilent
E7495A equipment must be connected to the LAN to detect it. Then
perform the procedures described in Appendix F (Specifically, see
Table F-1 on page F-3,  Table F-2, and Table F-3 on page F-4).
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Calibrating Test Equipment

The calibrate test equipment function zeros the power measurement level
of the test equipment item that is to be used for TX calibration and audit.
If both a power meter and an analyzer are connected, only the power
meter is zeroed.

NOTE The Agilent E4406A transmitter tester does not support power
measurement level zeroing. Refer to the Equipment Calibration
section of Appendix F for E4406A calibration.

Prerequisites
S LMF computer serial port and test equipment are connected to the

GPIB box.
S Test equipment to be calibrated has been connected correctly for tests

that are to be run.

S Test equipment has been selected in the LMF (Table 3-25 or
Table 3-26)

Calibrating test equipment

Follow the procedure in Table 3-27 to calibrate the test equipment.

Table 3-27: Test Equipment Calibration

n Step Action

1 From the Util menu, select Calibrate Test Equipment
from the pull–down menu. A Directions window is
displayed.

2 Follow the directions provided.

3 Click on Continue to close the Directions window and
start the calibration process. A status report window is
displayed.

4 Click on OK to close the status report window.
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Calibrating Cables Overview

The LMF Cable Calibration function is used to measure the path loss (in
dB) for the TX and RX cables, adapters, directional couplers, and
attenuators that make up the cable configurations used for testing. A
communications system analyzer is used to measure the loss of both the
TX test cable and the RX test cable configurations. LMF cable
calibration consists of the following processes:

Measure the loss of a short cable

This is done to compensate for any measurement error of the
communications system analyzer. The short cable, which is used only for
the calibration process, is connected in series with both the TX and RX
test cable configurations when they are measured.

The measured loss of the TX and RX test cable configurations minus the
measured loss of the short cable equals the actual loss of the
configurations. This is done so that any error in the analyzer
measurement is eliminated from both the TX and RX measurements.

Measure the loss of the short cable plus the RX test
cable configuration

The RX test cable configuration normally consists only of a coax cable
with type–N connectors that is long enough to reach from the BTS RX
connector to the test equipment.

When the BTS antenna connectors carry duplexed TX and RX signals, a
directional coupler is required and an additional attenuator may also be
required (for certain BTS types) for the RX test cable configuration.
These additional items must be included in the path loss measurement.

Measure the loss of the short cable plus the TX test
cable configuration

The TX test cable configuration normally consists of two coax cables
with type–N connectors, a directional coupler, a termination load with
sufficient rating to dissipate the BTS output power, and an additional
attenuator, if required by the BTS type. The total path loss of the TX test
configuration must be as required for the BTS (normally 30 or 50 dB).

The Motorola Cybertest analyzer differs from other communications
system analyzers because the required attenuation/load is built into the
test set. Because of this, the Cybertest TX test configuration consists
only of the required length coax cable.
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Calibrate Test Cabling using Communications System Analyzer

Cable Calibration is used to calibrate both TX and RX test cables.
Appendix F covers the procedures for manual cable calibration.

NOTE LMF cable calibration cannot be accomplished using an HP8921
analyzer for 1.7/1.9 GHz.  A different analyzer type or the signal
generator and spectrum analyzer method (Table 3-29 and
Figure 3-25) must be used. Cable calibration values must be
manually entered into the LMF cable loss file if the signal
generator and spectrum analyzer method is used. To use the
HP8921A for manual test cable configuration calibration for 800
MHz BTSs, refer to the Manual Cable Calibration section of
Appendix F.

Prerequisites

S Test equipment is turned on and has warmed up for at least 60
minutes. Agilent E7495A requires only 30 minute warmup.

S Test equipment has been selected in the LMF (Table 3-25 or
Table 3-26).

S Test equipment has been calibrated and correctly connected for the
type of test cable configuration to be  calibrated.

Calibrating cables

Refer to Figure 3-12, Figure 3-13, or Figure 3-14 and follow the
procedure in Table 3-28 to calibrate the test cable configurations.

Table 3-28: Test Cabling Calibration using Comm. System Analyzer

n Step Action

1 Click Util in the BTS menu bar, and select Cable
Calibration... in the pull–down menu. A Cable
Calibration window is displayed.

2 Enter one or more channel numbers in the Channels box

NOTE
Multiple channels numbers must be separated with a
comma, no space (i.e., 200,800). When two or more
channels numbers are entered, the cables are calibrated for
each channel. Interpolation is accomplished for other
channels as required for TX calibration.

3 Select TX and RX Cable Cal, TX Cable Cal, or RX
Cable Cal in the Cable Calibration pick list.

4 Click OK, and follow the directions displayed for each
step. A status report window will be displayed with the
results of the cable calibration.
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Calibrate Test Cabling Using Signal Generator & Spectrum Analyzer
Follow the procedure in Table 3-29 to calibrate the TX/Duplexed RX
cables using a signal generator and spectrum analyzer. Refer to
Figure 3-25, if required.  Follow the procedure in Table 3-30 to calibrate
the Non–Duplexed RX cables using the signal generator and spectrum
analyzer. Refer to Figure 3-26, if required.

Table 3-29: Calibrating TX/Duplexed RX Cables Using Signal Generator & Spectrum Analyzer

Step Action

1 Connect a short test cable between the spectrum analyzer and the signal generator as shown in
Figure 3-25, detail “A” (top portion of figure).

2 Set signal generator to 0 dBm at the customer frequency of:

869–894 MHz for North American Cellular or 1930–1990 MHz for North American PCS

3 Use spectrum analyzer to measure signal generator output (see Figure 3-25, A) & record the value.

4 Connect the spectrum analyzer’s short cable to point B, (as shown in the lower right portion of the
diagram) to measure cable output at customer frequency of:

869–894 MHz for North American Cellular or 1930–1990 MHz for North American PCS

Record the value at point B.

5 Calibration factor = (value measured with detail “A” setup) – (value measured with detail “B” setup)

Example: Cal factor = –1 dBm – (–53.5 dBm) = 52.5 dB

NOTE
The short cable is used for calibration only. It is not part of the final test setup. After calibration is
completed, do not re-arrange any cables. Use the test cable configuration as is to ensure test
procedures use the correct calibration factor.

 

Figure 3-25: Cal Setup for TX/Duplexed RX Test Cabling 
Using Signal Generator & Spectrum Analyzer
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Table 3-30: Calibrating Non–Duplexed RX Cables Using a Signal Generator  &Spectrum Analyzer

Step Action

NOTE
When preparing to calibrate a BTS with Duplexed TX and RX the RX cable calibration must be done
using calibration setup in Figure 3-25 and the procedure in Table 3-29.

1 Connect a short test cable between the spectrum analyzer and the signal generator as shown in
Figure 3-26, detail “A” (top portion of figure).

2 Set signal generator to –10 dBm at the customer’s RX frequency of:

824–849 for North American Cellular or 1850–1910 MHz band for North American PCS

3 Use spectrum analyzer to measure signal generator output (see Figure 3-26, A) and record the value.

4 Connect the test setup, as shown in the lower portion of the diagram (see Figure 3-26, B) to measure
the output at the customer’s RX frequency of:

824–849 for North American Cellular or 1850–1910 MHz band for North American PCS

Record the value at point B.

5 Calibration factor = (value measured with detail “A” setup) – (value measured with detail “B” setup)

Example: Cal factor = –1 dBm – (–53.5 dBm) = 52.5 dB

NOTE
The short cable is used for calibration only. It is not part of the final test setup. After calibration is
completed, do not re-arrange any cables. Use the test cable configuration as is to ensure test
procedures use the correct calibration factor.

 

Figure 3-26: Cal Setup for Non–Duplexed RX Test Cabling 
Using Signal Generator & Spectrum Analyzer
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Setting Cable Loss Values
Cable loss values for TX and RX test cable configurations are normally
set by accomplishing automatic cable calibration using the LMF and the
applicable test equipment. The LMF stores the measured loss values in
the cable loss files. The cable loss values can also be set or changed
manually. Follow the procedure in Table 3-31 to set cable loss values.

CAUTION If cable calibration was performed without using the LMF, cable
loss values must be manually entered in the LMF database.
Failure to do this will result in inaccurate BTS calibration and
reduced site performance.

Prerequisites
S LMF is logged into the BTS

Table 3-31: Setting Cable Loss Values

Step Action

1 Click Util in the BTS menu bar, and select Edit > Cable Loss in the pull–down menus.

– A tabbed data entry pop–up window will appear.

2 Click on the TX Cable Loss tab or the RX Cable Loss tab, as required.

3 To add a new channel number, perform the following:

3a – Click on the Add Row button.

3b – Click in the Channel # or Loss (dBm) column, as required.

3c – Enter the desired value.

4 To edit existing values, click in the data box to be changed and change the value.

5 To delete a row, click on the row and then click on the Delete Row button.

6 For each tab with changes, click on the Save button to save displayed values.

7 Click on the Dismiss button to close the window.

NOTE
S Values entered or changed after the Save button was used will be lost when the window is

dismissed.

S If cable loss values exist for two different channels the LMF will interpolate for all other channels.

S Entered values will be used by the LMF as soon as they are saved. It is not necessary to log out and
log back into the LMF for changes to take effect.
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Setting TX Coupler Loss Values

If an in–service TX coupler is installed, the coupler loss (e.g., 30 dB)
must be manually entered so it will be included in the LMF TX
calibration and audit calculations and RX FER Test. Follow the
procedure in Table 3-32 to set coupler loss values.

Prerequisites
S LMF is logged into the BTS

S Path loss, in dB, of the TX coupler must be known

Setting loss values

Table 3-32: Setting TX Coupler Loss Value

Step Action

1 Click Util in the BTS menu bar, and select Edit > Coupler
Loss... in the pull–down menus.

– A tabbed data entry pop–up window will appear.

2 Click on the TX Coupler Loss tab or the RX Coupler Loss
tab, as required

3 Click in the Loss (dBm) column for each carrier that has a
coupler and enter the appropriate value.

4 To edit existing values, click in the data box to be changed
and change the value.

5 For each tab with changes, click on the Save button to save
displayed values.

6 Click on the Dismiss button to close the window.

NOTE
S Values entered or changed after the Save button is used will

be lost when the window is dismissed.

S The In–Service Calibration check box in the Tools >
Options > BTS Options tab must be checked before
entered TX coupler loss values will be used by the TX
calibration and audit functions.

S New or changed values will be used by the LMF as soon as
they are saved. Logging out and logging in again are not
required to cause saved changes to take effect.
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Bay Level Offset Calibration

Introduction
Bay Level Offset (BLO) calibration is the central activity of the
optimization process. BLO calibration compensates for normal
equipment variations within the BTS RF paths and assures the correct
transmit power is available at the BTS antenna connectors to meet site
performance requirements.

RF Path Bay Level Offset Calibration
Calibration identifies the accumulated gain in every transmit path (BBX
slot) at the BTS site and stores that value in a BLO database calibration
table in the LMF. The BLOs are subsequently downloaded to each BBX.

For starter frames, each receive path starts at a BTS RX antenna port and
terminates at a backplane BBX slot. Each transmit path starts at a BBX
backplane slot, travels through the Power Amplifier (PA) and terminates
at a BTS TX antenna port.

For expansion frames each receive path starts at the BTS RX port of the
cell site starter frame, travels through the frame-to-frame expansion
cable, and terminates at a backplane BBX slot of the expansion frame.
The transmit path starts at a BBX backplane slot of the expansion frame,
travels though the PA and terminates at a BTS TX antenna port of the
same expansion frame.

Calibration identifies the accumulated gain in every transmit path (BBX
slot) at the BTS site and stores that value in a BLO database. Each
transmit path starts at a C–CCP shelf backplane BBX slot, travels
through the PA, and ends at a BTS TX antenna port. When the TX path
calibration is performed, the RX path BLO is automatically set to the
default value.

At omni sites, BBX slots 1 and 13 (redundant) are tested. At sector sites,
BBX slots 1 through 12, and 13 (redundant) are tested. Only those slots
(sectors) actually equipped in the current CDF are tested, regardless of
physical BBX board installation in the slot.

When to Calibrate BLOs
Calibration of BLOs is required:

S After initial BTS installation

S Once each year

S After replacing any of the following components or associated
interconnecting RF cabling:

– BBX board

– C–CCP shelf

– CIO card

– CIO to Power Amplifier backplane RF cable

– PA backplane

– PA

– TX filter / TX filter combiner

– TX thru-port cable to the top of frame
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TX Path Calibration

The TX Path Calibration assures correct site installation, cabling, and the
first order functionality of all installed equipment. The proper function
of each RF path is verified during calibration. The external test
equipment is used to validate/calibrate the TX paths of the BTS.

WARNING Before installing any test equipment directly to any TX OUT
connector you must first verify that there are no CDMA
channels keyed. Have the OMC–R place the sector assigned to
the LPA under test OOS. Failure to do so can result in serious
personal injury and/or equipment damage.

CAUTION Always wear a conductive, high impedance wrist strap while
handling any circuit card/module. If this is not done, there is a
high probability that the card/module could be damaged by ESD.

NOTE At new site installations, to facilitate the complete test of each
CCP shelf (if the shelf is not already fully populated with BBX
boards), move BBX boards from shelves currently not under test
and install them into the empty BBX slots of the shelf currently
being tested to insure that all BBX TX paths are tested.

– This procedure can be bypassed on operational sites that are
due for periodic optimization.

– Prior to testing, view the CDF file to verify the correct
BBX slots are equipped. Edit the file as required to include
BBX slots not currently equipped (per Systems
Engineering documentation).

BLO Calibration Data File

During the calibration process, the LMF creates a bts–n.cal calibration
(BLO) offset data file in the bts–n folder. After calibration has been
completed, this offset data must be downloaded to the BBXs using the
Download BLO function. An explanation of the file is shown below.

NOTE Due to the size of the file, Motorola recommends that you  print
out a hard copy of a bts.cal file and refer to it for the following
descriptions.

The CAL file is subdivided into sections organized on a per slot basis (a
slot Block).

Slot 1 contains the calibration data for the 12 BBX slots. Slot 20
contains the calibration data for the redundant BBX. Each BBX slot
header block contains:

S A creation Date and Time – broken down into separate parameters of
createMonth, createDay, createYear, createHour, and createMin.

S The number of calibration entries – fixed at 720 entries corresponding
to 360 calibration points of the CAL file including the slot header and
actual calibration data.
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S The calibration data for a BBX is organized as a large flat array. The
array is organized by branch, sector, and calibration point.

– The first breakdown of the array indicates which branch the
contained calibration points are for. The array covers transmit, main
receive and diversity receive offsets as follows:

Table 3-33: BLO BTS.cal File Array Assignments

Range Assignment

C[1]–C[240] Transmit

C[241]–C[480] Main Receive

C[481]–C[720] Diversity Receive

NOTE Slot 385 is the BLO for the RFDS.

– The second breakdown of the array is per sector. Configurations
supported are Omni, 3–sector or 6–sector.

Table 3-34: BTS.cal File Array (Per Sector)

BBX Sectorization TX RX RX Diversity

Slot[1] (Primary BBXs 1 through 12)

1 (Omni) 3–Sector, C[1]–C[20] C[241]–C[260] C[481]–C[500]

2
3–Sector,

1st
C i

C[21]–C[40] C[261]–C[280] C[501]–C[520]

3 6 Sector,
1st

Carrier C[41]–C[60] C[281]–C[300] C[521]–C[540]

4
1st

Carrier 3–Sector, C[61]–C[80] C[301]–C[320] C[541]–C[560]

5
Carrier 3–Sector,

3rd
C i

C[81]–C[100] C[321]–C[340] C[561]–C[580]

6 Carrier C[101]–C[120] C[341]–C[360] C[581]–C[600]

7 3–Sector, C[121]–C[140] C[361]–C[380] C[601]–C[620]

8
3–Sector,

2nd
C i

C[141]–C[160] C[381]–C[400] C[621]–C[640]

9 6 Sector,
2nd

Carrier C[161]–C[180] C[401]–C[420] C[641]–C[660]

10
2nd

Carrier 3–Sector, C[181]–C[200] C[421]–C[440] C[661]–C[680]

11
Carrier 3–Sector,

4th
C i

C[201]–C[220] C[441]–C[460] C[681]–C[700]

12 Carrier C[221]–C[240] C[461]–C[480] C[701]–C[720]

 . . . continued on next page
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Table 3-34: BTS.cal File Array (Per Sector)

BBX RX DiversityRXTXSectorization

Slot[20] (Redundant BBX–13)

1 (Omni) 3–Sector, C[1]–C[20] C[241]–C[260] C[481]–C[500]

2
3–Sector,

1st
C i

C[21]–C[40] C[261]–C[280] C[501]–C[520]

3 6 Sector,
1st

Carrier C[41]–C[60] C[281]–C[300] C[521]–C[540]

4
1st

Carrier 3–Sector, C[61]–C[80] C[301]–C[320] C[541]–C[560]

5
Carrier 3–Sector,

3rd
C i

C[81]–C[100] C[321]–C[340] C[561]–C[580]

6 Carrier C[101]–C[120] C[341]–C[360] C[581]–C[600]

 . . . continued on next page

7 3–Sector, C[121]–C[140] C[361]–C[380] C[601]–C[620]

8
3–Sector,

2nd
C i

C[141]–C[160] C[381]–C[400] C[621]–C[640]

9 6 Sector,
2nd

Carrier C[161]–C[180] C[401]–C[420] C[641]–C[660]

10
2nd

Carrier 3–Sector, C[181]–C[200] C[421]–C[440] C[661]–C[680]

11
Carrier 3–Sector,

4th
C i

C[201]–C[220] C[441]–C[460] C[681]–C[700]

12 Carrier C[221]–C[240] C[461]–C[480] C[701]–C[720]

S Ten calibration points per sector are supported for each branch. Two
entries are required for each calibration point.

S The first value (all odd entries) refer to the CDMA channel
(frequency) where the BLO is measured. The second value (all even
entries) is the power set level. The valid range for PwrLvlAdj is from
2500 to 27500 (2500 corresponds to –125 dBm and 27500
corresponds to +125 dBm).

S The 20 calibration entries for each sector/branch combination must be
stored in order of increasing frequency. If less than 10 points
(frequencies) are calibrated, the largest frequency that is calibrated is
repeated to fill out the 10 points.
Example:
C[1]=384, odd cal entry

=   1 ‘‘calibration point”
C[2]=19102, even cal entry
C[3]=777,
C[4]=19086,
.
.
C[19]=777,
C[20]=19086, (since only two cal points were calibrated this 

would be repeated for the next 8 points)

S When the BBX is loaded with image = data, the cal file data for the
BBX is downloaded to the device in the order it is stored in the cal
file. TxCal data is sent first, C[1] – C[240]. Sector 1’s ten calibration
points are sent (C[1] – C[20]) followed by sector 2’s ten calibration
points (C[21] – C[40]), etc. The RxCal data is sent next (C[241] –
C[480]), followed by the RxDCal data (C[481] – C[720]).

S Temperature compensation data is also stored in the cal file for each
set.
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